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Guarantee

This equipment is guaranteed against defects in materials and workmanship.
We will repair or replace products which prove to be defective during the
guarantee period as detailed on your invoice, provided they are returned to us
prepaid. The guarantee will not apply to:

e Equipment which has been modified or altered in any way without the
written permission of Campbell Scientific

e Batteries

e Any product which has been subjected to misuse, neglect, acts of God or
damage in transit.

Campbell Scientific will return guaranteed equipment by surface carrier
prepaid. Campbell Scientific will not reimburse the claimant for costs incurred
in removing and/or reinstalling equipment. This guarantee and the Company’s
obligation thereunder is in lieu of all other guarantees, expressed or implied,
including those of suitability and fitness for a particular purpose. Campbell
Scientific is not liable for consequential damage.

Please inform us before returning equipment and obtain a Repair Reference
Number whether the repair is under guarantee or not. Please state the faults as
clearly as possible, and if the product is out of the guarantee period it should
be accompanied by a purchase order. Quotations for repairs can be given on
request. It is the policy of Campbell Scientific to protect the health of its
employees and provide a safe working environment, in support of this policy a
“Declaration of Hazardous Material and Decontamination” form will be
issued for completion.

When returning equipment, the Repair Reference Number must be clearly
marked on the outside of the package. Complete the “Declaration of
Hazardous Material and Decontamination” form and ensure a completed copy
is returned with your goods. Please note your Repair may not be processed if
you do not include a copy of this form and Campbell Scientific Ltd reserves
the right to return goods at the customers’ expense.

Note that goods sent air freight are subject to Customs clearance fees which
Campbell Scientific will charge to customers. In many cases, these charges are
greater than the cost of the repair.

E CAMPBELL
=3 SCIENTIFIC

Campbell Scientific Ltd,
80 Hathern Road,
Shepshed, Loughborough, LE12 9GX, UK
Tel: +44 (0) 1509 601141
Fax: +44 (0) 1509 270924

Email: support@campbellsci.co.uk
www.campbellsci.co.uk



About this manual

Please note that this manual was originally produced by Campbell Scientific Inc. primarily for the North
American market. Some spellings, weights and measures may reflect this origin.

Some useful conversion factors:
Area: 1 in’ (square inch) = 645 mm? Mass: 1 0z. (ounce) = 28.35 g

1 Ib (pound weight) = 0.454 kg
Length: 1in. (inch) = 25.4 mm

1 ft (foot) = 304.8 mm Pressure: 1 psi (Ib/in?) = 68.95 mb
lyard=0.914 m
1 mile = 1.609 km Volume: 1 UK pint = 568.3 ml

1 UK gallon = 4.546 litres
1 US gallon = 3.785 litres

In addition, while most of the information in the manual is correct for all countries, certain information
is specific to the North American market and so may not be applicable to European users.

Differences include the U.S standard external power supply details where some information (for
example the AC transformer input voltage) will not be applicable for British/European use. Please note,
however, that when a power supply adapter is ordered it will be suitable for use in your country.

Reference to some radio transmitters, digital cell phones and aerials may also not be applicable
according to your locality.

Some brackets, shields and enclosure options, including wiring, are not sold as standard items in the
European market; in some cases alternatives are offered. Details of the alternatives will be covered in
separate manuals.

Part numbers prefixed with a “#” symbol are special order parts for use with non-EU variants or for
special installations. Please quote the full part number with the # when ordering.

Recycling information

At the end of this product’s life it should not be put in commercial or domestic refuse but
sent for recycling. Any batteries contained within the product or used during the
products life should be removed from the product and also be sent to an appropriate
recycling facility.

Campbell Scientific Ltd can advise on the recycling of the equipment and in some cases
[ arrange collection and the correct disposal of it, although charges may apply for some
items or territories.

For further advice or support, please contact Campbell Scientific Ltd, or your local agent.
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Safety

DANGER — MANY HAZARDS ARE ASSOCIATED WITH INSTALLING, USING, MAINTAINING, AND WORKING ON
OR AROUND TRIPODS, TOWERS, AND ANY ATTACHMENTS TO TRIPODS AND TOWERS SUCH AS SENSORS,
CROSSARMS, ENCLOSURES, ANTENNAS, ETC. FAILURE TO PROPERLY AND COMPLETELY ASSEMBLE,
INSTALL, OPERATE, USE, AND MAINTAIN TRIPODS, TOWERS, AND ATTACHMENTS, AND FAILURE TO HEED
WARNINGS, INCREASES THE RISK OF DEATH, ACCIDENT, SERIOUS INJURY, PROPERTY DAMAGE, AND
PRODUCT FAILURE. TAKE ALL REASONABLE PRECAUTIONS TO AVOID THESE HAZARDS. CHECK WITH YOUR
ORGANIZATION'S SAFETY COORDINATOR (OR POLICY) FOR PROCEDURES AND REQUIRED PROTECTIVE
EQUIPMENT PRIOR TO PERFORMING ANY WORK.

Use tripods, towers, and attachments to tripods and towers only for purposes for which they are designed. Do not
exceed design limits. Be familiar and comply with all instructions provided in product manuals. Manuals are
available at www.campbellsci.eu or by telephoning +44(0) 1509 828 888 (UK). You are responsible for conformance
with governing codes and regulations, including safety regulations, and the integrity and location of structures or land
to which towers, tripods, and any attachments are attached. Installation sites should be evaluated and approved by a
qualified engineer. If questions or concerns arise regarding installation, use, or maintenance of tripods, towers,
attachments, or electrical connections, consult with a licensed and qualified engineer or electrician.

General

e Prior to performing site or installation work, obtain required approvals and permits. Comply with all
governing structure-height regulations, such as those of the FAA in the USA.

e Use only qualified personnel for installation, use, and maintenance of tripods and towers, and any
attachments to tripods and towers. The use of licensed and qualified contractors is highly recommended.

e Read all applicable instructions carefully and understand procedures thoroughly before beginning work.

e Wear a hardhat and eye protection, and take other appropriate safety precautions while working on or
around tripods and towers.

e Do not climb tripods or towers at any time, and prohibit climbing by other persons. Take reasonable
precautions to secure tripod and tower sites from trespassers.

e Use only manufacturer recommended parts, materials, and tools.

Utility and Electrical

® You can be killed or sustain serious bodily injury if the tripod, tower, or attachments you are installing,
constructing, using, or maintaining, or a tool, stake, or anchor, come in contact with overhead or
underground utility lines.

e Maintain a distance of at least one-and-one-half times structure height, or 20 feet, or the distance
required by applicable law, whichever is greater, between overhead utility lines and the structure (tripod,
tower, attachments, or tools).

e  Prior to performing site or installation work, inform all utility companies and have all underground utilities
marked.

e Comply with all electrical codes. Electrical equipment and related grounding devices should be installed
by a licensed and qualified electrician.

Elevated Work and Weather
e  Exercise extreme caution when performing elevated work.
e Use appropriate equipment and safety practices.
e During installation and maintenance, keep tower and tripod sites clear of un-trained or non-essential
personnel. Take precautions to prevent elevated tools and objects from dropping.
e Do not perform any work in inclement weather, including wind, rain, snow, lightning, etc.

Maintenance
e  Periodically (at least yearly) check for wear and damage, including corrosion, stress cracks, frayed cables,
loose cable clamps, cable tightness, etc. and take necessary corrective actions.
e Periodically (at least yearly) check electrical ground connections.

WHILE EVERY ATTEMPT IS MADE TO EMBODY THE HIGHEST DEGREE OF SAFETY IN ALL CAMPBELL
SCIENTIFIC PRODUCTS, THE CUSTOMER ASSUMES ALL RISK FROM ANY INJURY RESULTING FROM IMPROPER
INSTALLATION, USE, OR MAINTENANCE OF TRIPODS, TOWERS, OR ATTACHMENTS TO TRIPODS AND TOWERS
SUCH AS SENSORS, CROSSARMS, ENCLOSURES, ANTENNAS, ETC.
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1. Cellular communications

This manual provides information for interfacing CELL200 Series 4G LTE Cellular Modules to
Campbell Scientific data loggers.

Use of the CELL200 series requires a cellular line of service. The products compatible with
Verizon, AT&T, T-Mobile, Vodafone, and Telstra are shown in the following table.

Cellular ,
Product Market AT&T T-Mobile Vodafone Telstra Other
protocol
4G LTE
with North
CELL205 : . v v
automatic | America
3G fallback?
United
CELL210 |4G LTE CAT-1
States
4G LTE
with
CELL215 | automatic EMEA v v
3Gand
2G fallback
4G LTE .
with Australia
CELL220 .| and New v v
automatic Zealand
3G fallback
CELL225 4G LTE Japan v
TMore than 600 other providers are available worldwide through Campbell Scientific. See Establish cellular service
(p. 3) for more information.
2 AT&T ended support of their 3G network service on February 22, 2022. To continue operation the CELL200 series
requires operating system 2.030 or newer. Use the web interface to find the CELL200 series OS version on the OS
Date field of the Status Tab. See Updating the operating system and firmware (p. 65) for more information.

Before using the CELL200 series, please review:

» Safety
» Pre-installation (p. 2)

CELL200-Series 4G LTE Cellular Module
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2. Precautions

« READ AND UNDERSTAND the Safety section at the front of this manual.

« An authorized technician shall verify that the installation and use of this product is in
accordance with the manufacturer’s instructions, recommendations and intended use.

« Although the CELL200 series is rugged, it should be handled as a precision instrument.
« Follow local regulations (see Compliance in Specifications [p. 24]).

« Protect from over-voltage.

« Protect from water.

« Protect from ESD (electrostatic discharge).

3. Initial inspection

e Upon receipt of the CELL200 series, inspect the packaging and contents for damage. File
any damage claims with the shipping company.

» Immediately check package contents. Thoroughly check all packaging material for product
that may be concealed. Check model numbers, part numbers, and product descriptions
against the shipping documents. Model or part numbers are found on each product.
Report any discrepancies to Campbell Scientific.

4. Pre-installation

TIP:
Check www.campbellsci.eu [ to ensure you are using the latest data logger support
software and data logger operating system (OS).

Updating the OS during system setup and testing, or on site is recommended. Sending an OS
to a remote data logger will interrupt the data logger program. If you have questions, contact
Campbell Scientific for assistance (https://www.campbellsci.eu/support). '



https://www.campbellsci.com/
https://www.campbellsci.com/support

4.1 Establish cellular service

For better security, we recommend using Konect PakBus® Router with a private dynamic IP
address. This method allows only incoming PakBus communications. No other incoming
communications are supported. However, all forms of outbound communications from the data
logger are supported, including but not limited to PakBus, email, and FTP.

NOTE:

When the data logger is connected to both Ethernet and a cellular modem, IPRoute () may
be used to specify which interface to use for the outbound communications, such as email,
FTP, and HTTP.

A public static IP address can also be used. This provides more incoming communications
functionality, but is less secure and more vulnerable to unsolicited traffic.

NOTE:
A public static IP account must be used when the module is set up in serial server mode.
Private dynamic IP accounts do not support the serial server mode.

4.1.1 Campbell Scientific cellular data service

Campbell Scientific can provide subscriptions to cellular service through Verizon, AT&T,
T-Mobile, Vodafone, Telstra, and over 600 other providers worldwide. When this cellular service
is purchased with the module, the module will come pre-provisioned with the required SIM card
and APN. If you have already purchased the CELL200 series, call Campbell Scientific to set up
service.

4.1.2 Other service providers

While using Campbell Scientific is the simplest way to obtain cellular data service for your
module, you can go directly to a provider. For more information on obtaining service directly
from Verizon and AT&T, see Verizon Wireless and AT&T (p. 80).

TIP:

Prepaid cellular data plans may experience service slow downs when data limits are reached.
If file transfer from a cellular-connected data logger works initially, but later has problems,
check for data overage on the cellular plan.

This does not apply to Campbell Scientific cellular data services.




4.2 Install the SIM card

NOTE:

If you purchased cellular service from Campbell Scientific with the module, it will come with
the SIM (Subscriber Identity Module) card already installed. Proceed to Konect PakBus Router
setup (p. 5).

NOTE:

Some SIM cards, particularly those purchased in Germany, come with an active personal
identification number (PIN). The PIN must be deactivated before proceeding. Often, an easy
way to deactivate the PIN is to install the SIM card in a mobile phone and use the device
settings.

The CELL200 series requires a Micro-SIM (3FF) (6 position / contacts); a smartcard that securely
stores the key identifying a mobile subscriber. You should only need to install the SIM card once
in the life of the module.

To install the SIM card:

1. Remove the SIM card cover.

2. Note the location of the notched corner for correct alignment. The gold contact points of
the SIM face down when inserting the SIM card as shown in the following figure. Gently
slide the card into the slot until it stops and locks into place. To eject the SIM card, press it
in slightly and release.

3. Replace the SIM card cover.

Figure 4-1. SIM card installation




4.3 Konect PakBus Router setup

For better security, we recommend using Konect PakBus® Router with a private dynamic IP
address. This method allows only incoming PakBus communications. No other incoming
communications are supported. However, all forms of outbound communications from the data
logger are supported, including but not limited to PakBus, email, and FTP.

4.3.1 Get started

You will need the Konect PakBus Router redemption code that came on a card with the CELL200
series.

omKonect

. Data Services from Campbell Scientific

Safe, secure routing for access to your IP-connected datalogger

Important Information! Do not discard!
Activate a Complimentary PakBus® Router on Campbell Scientific’s
Konect PakBus Routing Service. See the Getting Started Guide at:

http://campbellsci.com/start/pbrouter

REDEMPTION
CODE

Open a web browser and go to www.konectgds.com .

First-time users need to create a free account. After you submit your information, you will receive
two emails up to five minutes apart. One email will contain a Passport ID and the other your
Password. If emails are not received, check your email junk folder.

CELL200-Series 4G LTE Cellular Module
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http://www.konectgds.com/

. Data Services from Campbell Scientific

DATA COLLECTION

¥ LEARN MORE [E3 FREE ACCOUNT
CAMPBELL
- 4z

4.3.2 Set up Konect PakBus Router

1. Sign in to www.konectgds.com = using your Passport ID and Password found in the two
received emails. Once logged in, you will be at the Welcome page.

Welcome
# return to your home page Get started by adding a device, Introducing the CR1000X, an
system or service. Find the icon excellent choice for remote
@ notifications and messages below on the command bar to environmental applications,
the left and away you go... including weather stations,
Y favourites mesonet systems, wind
profiling, air quality monitoring,
'ﬂ devices and services hydrological systems, water
quality monitoring, and
? help hydrometeorological stations.

£+ your personal settings

ﬂ sign out

Remember you can get help at anytime whenever you see this symbol (7



http://www.konectgds.com/

2. Click Devices and services Bl on the command bar to the left and select Redeem PakBus
Router Code. Enter your complimentary Router Code found on the included card with your
cellular-enabled device and click Submit.

o
".‘D o+ Redeem PakBus Router Code

.}» View PakBus Router Status

Ao Get started by a Please enter your Complimentary Router Code
*%, Start 30-Day Device Trial system or servicqg
s below on the col

the left and awa

% Submit

3. The next screen shows the assigned DNS address and Port for the router. Enter a TCP
Password and select a unique PakBus Address for your data logger.

TIP:

Make note of this information; it will be required for data logger configuration as well as
LoggerNet setup. Please note your DNS, Port, TCP Password and PakBus address; you
will need them later.

Konect PakBus Router

A Router will be created for you on a new cluster

All Routers on a cluster share the same DNS, Port and TCP Password

DNS: acmnEd konectgds.com
Port 80
Enter a TCP Password or isave blank if not required

TCP Password

(no addresses currently in use)

‘You can select a PakBus address to use between 1 - 3999,
excluding any addresses already in use

PakBus Address 1

Submit

4. Click Submit.




&3 on the command bar and

5. To edit settings at a later date, click devices and services
select Manage PakBus Routers.

4‘ Redeem PakBus Router Code

4- View PakBus Router Status

«» Manage PakBus Routers

NOTE:
The DNS address and Port number, assigned when your account was setup, cannot be

edited.

5. Overview

The CELL200-series modules may be configured in one of five ways, depending on the data
logger, communications type, and needs of the user.

« Integrated: The module mimics the behaviour of our integrated cell modems. No settings
are configured directly in the module. All settings are configured in the attached data
logger.

« Non-integrated: The module mimics the behaviour of our older cellular modems. Settings
must be configured in both the module and the data logger.

« Serial Server: In this mode, the module receives IP communications over the cellular
network and converts those to serial communications to pass on to the data logger. From
the perspective of the data logger, this is no different than a serial cable connecting it to a

computer.

NOTE:

A public static IP account must be used when the module is set up in serial server mode.

Private dynamic IP accounts do not support the serial server mode.

CELL200-Series 4G LTE Cellular Module
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» Serial Client: Use this mode when the module is behind a cellular provider firewall and it has
a private dynamic IP address. In serial client mode the module will connect to the cellular
network and initiate a TCP client socket connection.

» Serial Server/Client: In serial server/client mode the module connects to the cellular
network and opens a listening port. When a client connects to the listening port, the
CELL200 series will be in "Serial Server" mode, as described earlier. When no client is
connected to the listening port, the CELL200 series will be in "Serial Client" mode, as
described earlier, and all data on the active port will be sent and received through the
initiated TCP client socket connection.

Data loggers compatible with each mode are shown in the following table.

Non- . .
Integrated Serial Serial

integrated

2 i 3
server client
PPP

PPP

GRANITE series/CR6

series/CR1000X/ v v v Vv
CR300 series!

CR1000/CR3000/CR800 series v v v v

CR200(X) series v N v

Array-based

(Edlog) data loggers v v v

TIntegrated PPP mode requires operating system 03.00 or later for the CR1000X, 09.00 or greater for the CR6
series, and 08.00 or later for the CR300 series.

2 Serial server mode requires a public static IP account.

3 Requires CELL200 series OS 2.00 or later.

NOTE:
PakBus data loggers include the following models: GRANITE-series, CR6, CR3000, CR1000X,

CR800-series, CR300-series, CR1000, and CR200(X)-series.

CELL200-Series 4G LTE Cellular Module 9



6. QuickStart (integrated mode)

NOTE:

This QuickStart describes configuring the CELL200 series in integrated mode (mimicking our
internal cell modems) with its default settings. It can also be configured in non integrated or

serial server mode.

This QuickStart section does not apply to CR3000, CR1000 and CR800-series users. See
Overview (p. 8) for more information on the different modes. See CELL200 series and data
logger configuration (p. 35) for more information on configuring the module in the different

modes.

The Provisioning Report received with your Cellular Data Service shows whether the module was
configured with a private dynamic or public static IP address. See Figure 6-1 (p. 10) for an example
of a Campbell Scientific Provisioning Report. Other cellular providers should provide similar

information.

I= CAMPBELL
5 scienTiFic

The folowing device has been

Sales Order #
Sales Order Date | 12/31/1969

Company i

Address

City
State

Count - -

Postal Code
Hardware

Model #
Serial#t

Provision Code

Data Plan
Data Limit
iccip
MSISDN .
IMEI

Renewal Due Date |2019-09-22

Cellular Data Service
Provisioning Report

provisioned for Campbell Scientific Cellular Data Service.

Sales Order Due Date | 12/31/1969
Date Provisioned | 11/06/2018

- Customer ID
Contact
Phone

Emall | s

Datalogger (-40.40 +70C) -CELL210 WiAG LTE CAT1 VZ VS Verizon
;gma’

( Static [P

Datalogger (-40 to +70C) CELL210 widG

LTE CAT1 VZ -VS Verizon US Static IP

Campbell Sci ata Service
Subscription -

CR300-CELL210-VS

CELLDATA-VS-A250

ferizon
A250 250MB/Mon for 1 Yr
Network | Verizon

Service Period | 11/15/2018 to 121412019

Figure 6-1. Static IP provisioning report

Additionally, Campbell Scientific cellular modules configured with a public static IP address will
have two stickers on the module, as shown in Figure 6-2 (p. 11). One sticker will show the module
phone number and data plan. The second sticker will show the static IP address.

Campbell Scientific cellular modules configured with a private dynamic IP address will have one
sticker on the module. It will show the module phone number and data plan.

10



Static IP Address
166.164 XX XX

CSI Cellular Data: 25 MB
MSISDN: 435 &4

Figure 6-2. Module with public static IP address

6.1 Modules using Konect PakBus Router
(private dynamic IP)

6.1.1 Set up hardware

1. Connect the cellular antenna, if it is not already connected. When using a MIMO antenna
with multiple cellular connections, connect the primary cable to Cellular and the secondary
to Diversity. If the cables are not marked in this way, they can be connected to either
antennna port.

2. Connect your data logger RS-232 or CS 1/O port to the CELL200-series module RS-232 or
CS 1/0 port. Ensure the same port is used for each device, for example RS-232 to RS-232.
See Wiring and connections (p. 29).

3. If not connecting through CS I/0O, provide power to the CELL200 series. The data logger
provides power through the CS I/0 port. USB power is not sufficient to power the CELL200
series; 12 V is required.

CELL200-Series 4G LTE Cellular Module
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6.1.2 Configure data logger

. Connect to your data logger by using Device Configuration Utility.

. On the Datalogger tab, change the data logger PakBus Address and PakBus/TCP Password
to match the values entered in the Konect PakBus Router setup. The PakBus/TCP Password
will make the data logger authenticate any incoming or outgoing PakBus/TCP connection.

Deployment

Datalogger fcom Ports Settings Ethernet CSIJQIP  FPP Metwork Services  TLS Advanced

Serial Mumber: PakBus Security
05 Version: [CR1000X.5td. | SearityCode 1: [0 |2
Station Name: [1001 | SearityCode2: [0 |2
PakBus Address: Il_l £ ] Security Code 3: EI =

PakBus Encryption Key: |

PakBus Encryption Key Confirm: |

|
|
FakBus,TCF Password: |00"0u |
|

Confirm PakBus,TCF Password: | LLLIET L]

. On the Network Services tab in the PakBus/TCP Client field, enter the DNS address and
Port number noted during the Konect PakBus Router setup.

. On the PPP tab, set Config/Port Used to CS I/O SDC8 or RS-232, depending on how you
are connected to the data logger.

. (Optional) On the PPP tab, set User Name and Password if required by your cellular carrier
(usually outside of the United Sates).

. Verify the Modem Dial String setting is blank.

. If connecting through RS-232, on the Comport Settings tab, set RS232 BaudRate to
115200 Fixed.

. Click Apply to save the changes. Verify the settings in the summary window.
(Recommended) Save a copy of the settings to a file on the computer. Click OK.

. Shut down Device Configuration Utility and start it again. This will activate the Cellular tab
needed for the next step.

12



10.

1.

12.
13.

On the Cellular tab, enter the APN provided by your cellular provider.

Deployment  Eettings Editor

Datalogger Com Ports Setﬁngs[ Cellular  fyetwork Services TLS  Advanced

Cell Modem Enable: |Enabled Status
State:
APN: |
Signal Strenagth:
Automated Power Schedule
Start (power-on) Time: | Always On Signal Quality:

On Duration: | 1 Hour
Cellular Metwork 5

Repeat Cyde: |Disabled IP: 0.
mask:

Click Apply to save the changes. Verify the settings in the summary window.
(Recommended) Save a copy of the settings to a file on the computer. Click OK.

Click Connect to reconnect in the Device Configuration Utility.

(Optional) By default, the CELL200 series will accept incoming communications from any IP
address. This can be a security risk. You may specify up to four IP addresses, with wild cards,
to limit connections to only those trusted sources. Use an asterisk (*) as a wild card. For
example, a setting of 166.22.*.* would allow connections from devices that have IP
addresses starting with 166.22. Both IPv4 and IPv6 addresses are supported.

CAUTION:
Only set a Trusted IP address if you are familiar with their use. Consult your IT
department or Campbell Scientific for assistance.

NOTE:
This setting does not affect outbound connections, only incoming connections.
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In the Settings Editor > Network Services tab, next to the Trusted Hosts field, click Edit and
Add your trusted IP addresses, one at a time.

Deployment Logger Control Data Monitor  Data Collection  File Control  Manage 05| Settings Editor  Frerminal

| &

Datalogger CSI/OIP PPP | Network Services kumPorts Settings Ethernet Advanced TLS

Maximum TCP Segment Size

-

PakBus/TCP Service Port
:

PakBus/TCP Client Connections

Edit

Trusted Hosts

Edit

14. Click Apply to save the changes. Verify the settings in the summary window.
(Recommended) Save a copy of the settings to a file on the computer. Click OK.

15. Click Disconnect and close Device Configuration Utility.

6.1.3 Set up LoggerNet

The LoggerNet Network Map is configured from the LoggerNet Setup screen.

NOTE:
Setup has two options, EZ (simplified) and Standard. Click on the View menu at the top of the
Setup screen, and select Standard view.

From the LoggerNet toolbar, click Main > Setup and configure the Network Map as described in
the following steps:

1. Select Add Root > IPPort.
2. Select PakBusPort and pbRouter for PakBus data loggers such as the CR6 or CR1000X.

~ B8 |PPort
v .55 PakBusPort
V--ﬂ pbRouter
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NOTE:

PakBus data loggers include the following models: GRANITE-series, CR6, CR3000,
CR1000X, CR800-series, CR300-series, CR1000, and CR200(X)-series.

3. Add a data logger to the pbRouter.

4. From the Entire Network, on the left side, select the IPPort. Enter the Konect PakBus Router
DNS address and port number as noted in the Konect PakBus Router setup (Set up Konect
PakBus Router [p. 6]). Enter them into the Internet IP Address field in the format DNS:Port
with a colon separating DNS and Port. For example, axanar.konectgds.com:pppp where
pppp is the port number.

Setup Screen

File View Backup Tools Help

9| B B V|V ¢
Display i Add Root Add Delete Rename Undo Redo
Entice blebaorck e
i
b B8 |PPort Eﬁ- IPPart : IPPort
—'-'-%rhthF‘ort Hord
Vu pbRouter arcware | Notes
‘&l CR1000¥Series Standard

Communications Enabled

Internet IP Address

Advanced
[ call-Back Enabled

I TCP Listen Only
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Leave the default settings for the PakBusPort. PakBus Port Always Open should not be
checked. In the TCP Password field enter the TCP Password; this must match the value
entered in the Konect PakBus Router setup and LoggerNet setup.

Setup Screen - Standard View

File Wiew Backup Tools Help

= <

T ¥V V| v o

Subnet b Display Add Root Add Delete Rename Undao Redo
MNetwaork Map
PakBusPort : PakBusPort
M e Hardware Mew PakBus Modes Motes
i) PakBusPort standard
Communications Enabled
[]PakBus Port Always Open
Maximum Time On-Line I 00h 00m 00 s )
Beacon Interval I 00h 01mO0s [l
PakBus Verify Interval I O0h O0m 005 L2l
Advanced
Extra Response Time I 00s =
PakBus Address 4016
Delay Hangup | 00 s 000 ms -+
TCP Password |.ooo.oo|
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6. For PakBus data loggers, select the pbRouter in the Network Map and set the PakBus

Address to 4070.

Setup Screen

File View Backup Tools Help
J % T T V| B
Display Add Root Add Delete Rename Undo Redo
Entire Network
~ 28 |PPort pbRouter : pbRouter
R R
v pbRouter Hardware | Notes
= Standard
Communications Enabled
| PakBus Address [4070 |
vanced
Maximum Packet Size |993 |

7. For PakBus data loggers, select the data logger in the Network Map and set the PakBus
Address to match that of the data logger (default address in the data loggeris 1). If a
PakBus Encryption Key was entered during data logger setup, also enter it here. Click Apply
to save the changes.

v e

Setup Screen — O *
File View Backup Tools Help
@ | B B V| W o B
Display Add Root Add Delete Rename Undo Redo EZ View
Entire Network
< & 1PPort Bl | CcR1000XSeries : CR1DD0KSeries
~ g PakBusPart
A Hardware Schedule DataFiles Clock Program File Retrieval MNotes

Standard
Communications Enabled

Call-Back Enabled

|PakBus Address 1
vance

Maximum Packet Size 998
Security Code 0
Delay Hangup I 00 5 000 ms =

PakBus Encryption Key

Check Cancel

Apply

Mo final storage tables are defined in the station's program.
Scheduled Data Collection is disabled.
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6.1.4 Test the connection

After the Network Map has been configured, test the cellular connection by using the Connect
screen as shown in the following image. Click on the appropriate station and click Connect to
initiate a call to the data logger.

TIP:
The connection time is subject to many external factors. It is often less than 30 seconds but
could be up to 15 minutes. Be patient.

If the connection is successful, the connectors icon at the bottom of the screen will come
together and clock information from the data logger will be displayed in the Station Date/Time
field. If the connection fails, a Communications Failure message will be displayed.

Connect Screen: CR1000XSeries (CR1000XSeries) — O .
File Edit View Datalogger Help
é o E =
Disconnect Collect Now Custom Station Status  File Control MNum Display Graphs Ports & Flags
Stations Table Monitor: Real Time Monitoring Clocks
=8 CR1000XSeries - Show Units Adjusted Ser\.rer .Dateu"Time
6/13/2018 2:30:44 PM
Field Value
Station Date/Time
6/13/2018 2:30:44 PM
Check Set
[1Pause Clock Update
Current Program
SCWinEx1.CR1X
Send Mew... Retrieve...
[ List Alphabetically < >
MNotes
m 0 00:00:15 Stop Interval | 00m 01 = |

6.2 Modules using a public static IP
6.2.1 Set up hardware

1. Connect the cellular antenna, if it is not already connected. When using a MIMO antenna
with multiple cellular connections, connect the primary cable to Cellular and the secondary
to Diversity. If the cables are not marked in this way, they can be connected to either
antennna port.
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2. Connect your data logger RS-232 or CS 1/O port to the CELL200-series module RS-232 or
CS 1/0 port. Ensure the same port is used for each device, for example RS-232 to RS-232.
See Wiring and connections (p. 29).

3. If not connecting through CS I/O, provide power to the CELL200 series. The data logger
provides power through the CS I/O port. USB power is not sufficient to power the CELL200
series; 12 V is required.

6.2.2 Configure data logger

1. Connect to your data logger by using Device Configuration Utility.

2. On the PPP tab, set Config/Port Used to CS I/O SDC8 or RS-232, depending on how you
are connected to the data logger.

3. (Optional) On the PPP tab, set User Name and Password if required by your cellular carrier
(usually outside of the United Sates).

4. Verify the Modem Dial String setting is blank.

5. If connecting through RS-232, on the Comport Settings tab, set RS232 BaudRate to 115200
Fixed.




6. On the Cellular tab, enter the APN provided by your cellular provider.

)} Device Configuration Utility 2.19 Beta = m} X
File Backup Options Help
Deployment  [ogger Control Data Monitor  Data Collection  File Control Manage 05 Settings Editor  Terminal

Device Type
Q search &’ Datalogger Com Ports Settings Ethernet CSIOIP PPP | Celular Metwork Services TLS — Advanced
Cellular Modem 7
E Datalogger Cell Modem Enable: Status
. State: ‘Netwnrkready. Datalogger ready.
CR1000 | e | ||

CR1000X Series Signal Strength:
g PDP User Mame:

CR200 Series PDP Password: Show
CRI3X-PB Automated Power Schedule Cellular Network Status
CR300 Series Start (power-on) Time: | AlwaysOn Cellular is the default network.
s PPP State: IP Opened

300 :
i On Duration: | 1 Haur P: 10.64.64.64

b gw: 10.64.64.
RO dns: 198.224,173.135
CRE Series Repeat Cyde: |Disabled dne: 198,224,174, 135

dns: 208.67.222.222
CRE00 Series Ping Keep Alive
CR9 Series URL:
CRVW Serie:
sl Timeout:

Datalogger (Other)
=3 Hetwork Peripheral
NL100

ML200 Series w

Communication Port

Ccom7
~
Use IP Connection APN
Pk iyt Key Specifies the APN (Access Point Name), and is required.
Baud Rate The APN is the gateway between the cellular network and the internet.
tharl Mote: This setting is stored in the CELL2x¢. v

Apply Cancel Factory Defavlts Read File Summary

7. (Optional) By default, the CELL200 series will accept incoming communications from any IP
address. This can be a security risk. You may specify up to four IP addresses, with wild cards,
to limit connections to only those trusted sources. Use an asterisk (*) as a wild card. For
example, a setting of 166.22.* * would allow connections from devices that have IP
addresses starting with 166.22. Both IPv4 and IPv6 addresses are supported.

CAUTION:
Only set a Trusted IP address if you are familiar with their use. Consult your IT
department or Campbell Scientific for assistance.

NOTE:
This setting does not affect outbound connections, only incoming connections.
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In the Device Configuration Utility go to the Settings Editor then Network Services. Next to
the Trusted Hosts field, click Edit and Add your trusted IP addresses, one at a time.

Deployment Logger Control Data Monitor  Data Collection  File Control  Manage 05| Settings Editor  Frerminal

| &

Datalogger CSI/OIP PPP | Network Services l:umPorts Settings Ethernet Advanced TLS

Maximum TCP Segment Size

-

PakBus/TCP Service Port
:

PakBus/TCP Client Connections

Edit

Trusted Hosts

Edit

8. Click Apply to save the changes.

6.2.3 Set up LoggerNet

The LoggerNet Network Map is configured from the LoggerNet Setup screen.

NOTE:
Setup has two options, EZ (simplified) and Standard. Click on the View menu at the top of the
Setup screen, and select Standard view.

From the LoggerNet toolbar, click Main > Setup and configure the Network Map as described in
the following steps:

1. Select Add Root > IPPort.
2. Select PakBusPort.
3. Add a data logger to the PakBusPort.
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4. Select the IPPort in the Network Map. Enter the CELL200 series IP address and port
number. The IP address and port number are input in the Internet IP Address field
separated by a colon. Preceding zeros are not entered in the Internet IP Address (for

example, 070.218.074.247 is entered as 70.218.74.247). The default port number is 6785.

aSetup Screen
File View Backup Tools

<

-
Display Add Root

Help

!

Add

B8 |PPort
sPort
L. CR1000MSeries

- O X
Delete Repame Undo Redo EZ View
B
IPPort : IPPart

Hardware potes

Standard

Communications Enabled

.|

[ Internet IP Address © 6785 1 9'
Advanced

[ call-Back Enabled

[J1cp Listen Only

5. For PakBus data loggers, leave the default settings for the PakBusPort. PakBus Port Always
Open should not be checked. If a TCP Password is used, enter it.

E3 Setup Screen

. File View Backup Tools Help

-
Display

Entire Metwoark

2

Add Root

T

Add

L= 1- R
%4 PakBusPort
----- erigs

5]

Delete

T

Rename ‘ gndn Redo

% PakBusPort : PakBusPort

Hardware Mew PakBus Naodes
Standard
Communications Enabled

[ ] PakBus Port Always Open

Motes

Maximum Time On-Line

00 h oo

CELL200-Series 4G LTE Cellular Module
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6. For PakBus data loggers, select the data logger in the Network Map and set the PakBus
Address to match that of the data logger (default address in the data loggeris 1). If a

PakBus Encryption Key was entered during data logger setup, also enter it here. Click Apply
to save the changes.

Setup Screen = O X
File View Backup Tools Help
J o B B V| O 3¢}
Display Add Root Add Delete Rename Unda Redo EZ View
Entire Metwork |
< B [PPart & | cR1000XSeries : CR1000XSeries
Wl D E Dot -
--El CR1000X5eries Hardware Schedule Data Files Clock Program File Retrieval Motes

Standard
Communications Enabled

[~ call-Back Enabled

PakBus Address 1

avanced

Maximum Packet Size 998
Security Code o

Delay Hangup 00 s 000 ms

PakBus Encryption Key |

Scheduled Data Collection is disabled.

Check Apply Cancel

6.2.4 Test the connection

After the Network Map has been configured, test the cellular connection by using the Connect

screen as shown in the following image. Click on the appropriate station and click Connect to
initiate a call to the data logger.

TIP:

The connection time is subject to many external factors. It is often less than 30 seconds but
could be up to 15 minutes. Be patient.
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If the connection is successful, the connectors icon at the bottom of the screen will come
together and clock information from the data logger will be displayed in the Station Date/Time
field. If the connection fails, a Communications Failure message will be displayed.

Connect Screen: CR1000XSeries (CR1000XSeries) — O x
File Edit View Datalogger Help
» D o 5] E =
Disconnect Collect Now Custom Station Status  File Control MNum Display Graphs Ports 8 Flags
Stations Table Moniter: Real Time Monitering Clocks
= CR1000XSeries - Show Units Adjusted Server .DEtEu"TII'ﬂE
6/13/2018 2:30:44 PM
Field Value
Station Date/Time
6/13/2018 2:30:44 PM
Check Set
[1Pause Clock Update
Current Program
SCWinEx1.CR1X
Send MNew... Retrieve...
[ List Alphabetically = %
Motes
L (] 0 00:00:15 Stop Interval | 00m 01 = |

/. Specifications

Data Logger Compatibility

The CELL200 series is compatible with the GRANITE-series, CR6, CR3000, CR1000X, CR800-series,
CR300-series, CR1000, CR200(X) series, CR5000, CR10X, CR10X-PB, CR510, CR510-PB, CR23X, and
CR23X-PB. See Module communications connections (p. 29) for information on communications
options with each data logger model.

Cellular WAN

See https://s.campbellsci.com/documents/us/miscellaneous/Cellular Modem Frequency
Bands.pdﬂ:;llfor a complete list of supported frequency bands.

Host Interfaces

e CS1/O communications port, DB9 male
e RS-232 serial port, DB9 female
» USB version 2.0 with micro-B connector
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RF Connectors
» 2 SMA antenna connectors (primary and diversity)
Power

» Operating Voltage: 10 to 30 VDC
Low Power Mode: 300 pA
Typical Idle: 14 mA @ 12 VDC

25 mA @ 12 VDC (CELL210)
Size

¢ Dimensions: 13.46 X 8.1 X 2.86 cm (5.3 X319 X 1.13in)
e Weight: 215.5g (7.6 02)

Environmental

e Operating Temperature Range: —40 to 80 °C
e Storage Temperature: =45 to 80 °C
e Humidity: 10 to 90%

Industry Certifications
e Environmental: RoHS
SIM (Subscriber Identity Module) card interface

e Micro-SIM (3FF) (6 position / contacts)
» Supports SIMs that require 1.8 or 3 VDC

Data Speeds

e LTE: Max 10 Mbps (download) / Max 5 Mbps (upload)

» WCDMA: Max 384 Kbps (download) / Max 384 Kbps (upload)

e GSM
° EDGE: Max 296 Kbps (download) / Max 236.8 Kbps (upload)
° GPRS: Max 107 Kbps (download) / Max 85.6 Kbps (upload)

Typical Active: 39 mA @ 12 VDC (CELL205, CELL215, CELL220, CELL225)
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Compliance

« Industry Canada (IC): 10224A-201611EC21A
« View Declaration of Conformity at:

www.campbellsci.eu/cell205 [
www.campbellsci.eu/cell210 7
www.campbellsci.eu/cell215 [
www.campbellsci.eu/cell220 [

www.campbellsci.eu/cell225 [

8. Installation

8.1 Base station requirements ... 26
8.2 Data logger site equipment ... 27
8.3 Wiring and connections ... 29
8.3.1 Module communications connections ... 29
8.3.2 Module power connections ... 32
8.3.3 Antenna conNectionS ... 33
8.4 CELL200 series and data logger configuration ... 35
8.4.1 Integrated mode option ... 35
8.4.2 Non-integrated mode option ... 35
8.4.3 Serial server mode option ... 41
8.4.4 Serial client mode option ... 47
8.4.5 Serial server/client mode option ... 53

8.1 Base station requirements

A computer running Campbell Scientific LoggerNet software with access to the Internet is

needed.

CELL200-Series 4G LTE Cellular Module
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8.2 Data logger site equipment

CELL200-series module with power cable (included with module)

Data logger — GRANITE series, CR6 series, CR3000, CR1000X series, CR300 series, CR1000,
CR800 series, and CR5000

Module Interface, see Module communications connections (p. 29)

Environmental Enclosure — ENC10/12, ENC12/14, ENC14/16 or ENC16/18

If connecting to CS I/O port:

SC12 cable (preferred for GRANITE series, CR6 series, CR3000, CR1000X series, CR1000,
CR800 series, and CR5000 data loggers) — connects the module to current data logger
with a CS 1/0 port. See CS /O connection (p. 31)

SC105 Interface — connects the module to any data logger with a CS I/O port. It must be
configured using Device Configuration Utility. Settings should be:

e CS1/0O Mode: SDC Address 8
e CS1/O ME Baud Rate: 115.2k
e RS-232 Mode: Modem (default)
e Baud Rate:
» 115.2k fixed for GRANITE series, CR6 series, CR3000, CR1000X series, CR1000,
CR800 series, and CR5000 data loggers
* 9600 for CR10X, CR10X-PB, CR510, CR510-PB, CR23X, and CR23X-PB data
loggers
8 data bits, 1stop bit, no parity

If connecting to RS-232 port:

Null Modem Cable (9 pin, male-to-male) — connects the module to the CR300 series,
CR1000, CR3000, CR800 series, and CR200(X) series RS-232 port.

CPI/RS-232 RJ45 to DB9 Cable — connects the module to the CR6 series or CR1000X
series CPI/RS-232 port.

» Antenna — the following antennas are available from Campbell Scientific. Contact
Campbell Scientific for help in determining the best antennas for your application.

o 2dBd 4G/3G Omnidirectional Antenna: An omnidirectional antenna with mounting
bracket that is ideally suited for use with 4G and 3G cellular gateways. The mounting
bracket attaches to a mast or crossarm, and it serves as the antenna ground plane.
The antenna has an N type (female) threaded permanent stud for easy mounting to
the included bracket or through an enclosure wall. A coaxial cable, sold separately, is
required to connect this antenna to the inline surge suppression or module antenna
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jack. The antenna includes a mount/U-bolt assembly for attaching the antenna to a
mast, post, or crossarm up to 3.8 cm (1.5 in) in diameter.

° The 38485 antenna is a wideband, dual-port, directional-panel antenna with slant 45
polarization that covers US LTE700/Cellular/PCS/AWS/MDS and global
GSM900/GSM1800/UMTS/LTE2600 bands. The antenna is designed for fixed
installations and is ideal for both indoor and outdoor applications. It includes a UV-
stable enclosure that provides years of use without degradation to either mechanical
properties or aesthetics. It also includes a mount assembly that secures the antenna
to a mast or pole using hose clamps and mast mount adapter. The antenna can also
be directly mounted on a wall.

° 8 dBd Yagi Wideband Antenna: A higher gain antenna that should be "aimed” at the
service provider antenna. It covers both the 800-MHz band and the 1.9-GHz band.
The antenna comes with bracket/U-bolt assembly for attaching the antenna to a
mast or post. A coaxial cable, sold separately, is required to connect this antenna to
the inline surge suppression or module antenna jack. This antenna is recommended
for areas that require a higher gain antenna.

28



° 4G/3G Cellular Whip Antenna with SMA Connector: A wideband termination antenna

with SMA connector and articulating base. This antenna is intended for short-term
testing use only. It is not intended for long-term use. Campbell Scientific
recommends that customers use external antennas for the best reception and
transmission of cellular signals.

NOTE:

When antennas are located away from the CELL200 series, keep the cables as short as
possible to prevent the loss of antenna gain. Route the cables to protect them from damage
and so they will not be snagged or pulled on. Avoid binding or sharp corners in the cable
routing. Bundle and tie off excess cable. Make sure the cables are secured so their weight will
not loosen the connector from the CELL200 series over time.

TIP:

Cellular phone apps, such as OpenSignal (https://opensignal.com/IZ7I|), show the direction to
point an antenna to get the best signal strength.

8.3 Wiring and connections

This section explains how to connect the module for different communications methods. It also
describes how to power the module and connect an antenna.

8.3.1 Module communications connections

The following table shows communications options for each Campbell Scientific data logger
model.
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Table 8-1: CELL200 series data logger compatibility chart

Connecting to CELL200 series
via its CS |/O port

Data logger model

Connecting to CELL200 series
via its RS- 232 port

RS-232 null modem cable, or

CR300 N/A C-port to RS-232 cable
(PPP or serial server)
RS-232 null modem cable, or
CR310 N/A C-port to RS-232 cable
(PPP or serial server)
GRANITE 6 SC12 CS 1/O cable CPI/RS-232 cable, or
(PPP and serial server) C- or U-port to RS-232 cable, or
CRO SC105 CS 1/O to RS-232 interface
GRANITE 10/9 SC12 CS 1/O cable CPI/RS-232 cable, or
(PPP and serial server) C-port to RS-232 cable, or
CRI000X SC105 CS 1/0 to RS-232 interface
RS-232 null I
CR200(X) N/A S-232 null modem cable

(serial server only)

SC12 CS1/O cable

RS-232 null modem cable
(PPP or serial server), or

R8
Sttt (PPP and serial server) C-port to RS-232 cable, or
SC105 CS I/0O to RS-232 interface
RS-232 null modem cable
CR1000 SC12 CS 1/O cable (PPP or serial server), or
(PPP and serial server) C-port to RS-232 cable, or
SC105 CS 1/0 to RS-232 interface
RS-232 null modem cable
CR3000 SC12 CS 1/O cable (PPP or serial server), or
(PPP and serial server) C-port to RS-232 cable, or
SC105 CS 1/0O to RS-232 interface
CR5000 N/A RS—232.nuII modem cable
(serial server only)
CR510 and CR10X N/A SC105 CS I/0O to RS-232 interface

CELL200-Series 4G LTE Cellular Module
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Table 8-1: CELL200 series data logger compatibility chart
Connecting to CELL200 series Connecting to CELL200 series

Data logger model

via its CS I/O port via its RS- 232 port
SC12 CS1/O cable
CR510-PB and CR10X-PB (serial server only) SC105 CS 1/O to RS-232 interface
(SDC7 and SDC8 only)
RS-232 null modem cable
CR23X N/A (serial server only), or
SC105 CS 1/0 to RS-232 interface
SC12 CS 1/O cable RS-232 null modem cable
CR23X-PB (serial server only) (serial server only), or
(SDC7 and SDC8 only) SC105 CS 1/0O to RS-232 interface

Figure 8-1(p. 31), Figure 8-2 (p. 32), and Figure 8-3 (p. 32) illustrate the most common
communications connections between a data logger and a CELL200 series.

CS 1/0 connection using an SC12 cable

The SC12 is used to connect the module to a data logger CS 1/O port.
Figure 8-1. CS I/O connection
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RS-232 connection using a null modem cable

Null Modem Cable is used to connect the module to the CR3000, CR800, CR2XX, CR300
series, or CR1000 RS-232 port. Power is provided from the 12V or SW12V port of the data
logger.

Figure 8-2. RS-232 connection

CR1000X or CR6 RS-232 connection using a CPI/RS-232 cable

RS-232/CPI RJ45 to DB9 Male DTE is used to connect the module to the CR6 or CR1000X.
Power is provided from the 12V or SW12V port of the data logger.

Figure 8-3. CR6/CR1000X RS-232 connection

8.3.2 Module power connections

When connecting through the CS /O port, power for the module is provided by the data logger.
When connecting through the RS-232 port, power must be supplied through the PowerIn
connector.

Controlling power to the CELL200 series (p. 62) provides an example CRBasic program using the
IPNetPower () instruction to control power to the CELL200 series. This functionality is available
in the CR300 series (all operating systems), the CR6 series with operating system 09.00 or greater,
and the CR1000X with operating system 03.00 or greater. To control power in these data loggers
with older operating systems or any CR1000, CR800 series, or CR3000, you will need to use a
SW12V port on the data logger and communicate over RS-232.

Alternatively, GRANITE series, CR6 series, CR3000, CR1000X series, CR300 series, CR1000, CR800
series, and CR5000 can use terminal commands to control power. Downloadable example
programs are available at www.campbellsci.eu/downloads/cell200-example-programs. [’
Search for "deep sleep" and "wakeup" inthe CELL2XX-Settings program.
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communications

CR1000, CR800 series, and CR3000 CRBasic programs require PPPC1lose before the "deep
sleep"” command and PPPOpen before the "wakeup" command.

The USB port provides power for module configuration, but is not sufficient for normal operation.

8.3.3 Antenna connections

Use of a diversity antenna can improve system performance. It is required in 4G networks, but
not 2G or 3G.

Figure 8-4. Antenna connections

1. Connect the cellular antenna to the Primary Antenna connector. Mount the cellular
antenna so there is at least 20 cm between the antenna and the user or any bystander.

2. Connect a second antenna, if used, to the Diversity Antenna connector.

Antenna diversity, also called space diversity, is a scheme that uses two or more antennas to
improve the quality and reliability of a wireless link. Often, especially in urban and indoor
environments, there is no clear line of sight between transmitter and receiver. Instead, the signal
is reflected along multiple paths before finally being received. Each bounce can introduce phase
shifts, time delays, attenuations, and distortions that can destructively interfere with one another
at the aperture of the receiving antenna. Diversity-antenna-capable devices support multiple
antennas (usually two) in order to combat this phenomenon and minimize its effects.
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Diversity antennas are not required for 2G/3G connections; however, they are highly
recommended in order to get the most reliable connection, especially in areas of low coverage.
Identical or very similar antennas should also be used for the best results.

For 4G networks, the second antenna operates as a MIMO (multiple input, multiple output)
antenna, providing a second receive path. This connection is required for operation on 4G/LTE
networks.

Table 8-2: Recommended antenna separation

Fearey | Wevakneinm Best a.ntenna Good éntenna
(MH2) ) separation (mm)  separation (mm)
(172N (174N

LTE 700 428 214 107

LTE 800 375 187 94

LTE 900 333 167 83

LTE 1800 167 83 42

LTE 2100 143 71 36

LTE 2600 115 58 29

WCDMA 850 353 176 88

WCDMA 900 333 167 83

WCDMA 1900 158 79 39

WCDMA 2100 143 71 36

CDMA/EV-DO 800 375 187 94

CDMA/EV-DO 1900 158 79 39

GSM/GPRS/EDGE 850 353 176 88

GSM/GPRS/EDGE 900 333 167 83

GSM/GPRS/EDGE 1800 167 83 42

GSM/GPRS/EDGE 1900 158 79 39
WARNING:

Antenna may not exceed the maximum gain specified in RF exposure (p. 82).

In more complex installations, such as those requiring long cable lengths or multiple connections,
you must follow the maximum dBi gain guidelines specified by the radio communications
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regulations of the Federal Communications Commission (FCC), Industry Canada, ACMA in

Australia, or your country's regulatory body.

8.4 CELL200 series and data logger
configuration

NOTE:

Instructions in this section assume that the steps in Pre-installation (p. 2) have been
completed. Cellular service must be setup before web access using cell.linktodevice.com s

available.

Select the installation option that best suits your application. The Overview (p. 8) section

describes the differences.

8.4.1 Integrated mode option ...

8.4.2 Non-integrated mode option

8.4.3 Serial server mode option ...

8.4.4 Serial client mode option ...

8.4.5 Serial server/client mode option

8.4.1 Integrated mode option

QuickStart (integrated mode) (p. 10) describes setting up the CELL200 series in integrated mode

with its default settings.

If the module is not in its default settings, the settings in the CELL200 series must match those in
the data logger for integrated mode to work. This includes the SDC Address for CS 1/0
communications or the RS-232 Baud Rate for RS 232 communications. Once these settings

match, all other configuration changes can be done in the data logger as described in QuickStart

(integrated mode) (p. 10).

See Non-integrated mode option (p. 35) for information on changing these settings in the

CELL200 series and data logger.

8.4.2 Non-integrated mode option

In non-integrated mode, the module mimics the behaviour of our older cellular modems. This
mode should be used when doing a direct replacement of a Raven or an RV50 modem.

CELL200-Series 4G LTE Cellular Module
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NOTE:
This section only applies to CR3000, CR1000 and CR800-series users.

8.4.2.1 Configure CELL200 series

1.
2.

Connect a USB cable between your module and computer.

Connect the cellular antenna, if it is not already connected. When using a MIMO antenna
with multiple cellular connections, connect the primary cable to Cellular and the secondary
to Diversity. If the cables are not marked in this way, they can be connected to either
antennna port. See Antenna connections (p. 33).

Open a web browser and go to: cell.linktodevice.com o

TIP:
If this doesn't work browse to 192.168.86.1.

On the Settings tab, enter the APN provided by your cellular provider.
If you will be connecting through CS 1/O, select the desired SDC Address.
If you will be connecting through RS-232, select the desired RS232 Baud Rate.

8.4.2.2 Configure data logger

N

Connect to your data logger using Device Configuration Utility.
If using the Konect PakBus Router:

a. On the Datalogger tab, change the data logger PakBus Address and optional
PakBus/TCP Password to match the values entered in the Konect PakBus Router
setup.

b. On the Network Services tab in the PakBus/TCP Client field, enter the DNS address
and Port number noted during the Konect PakBus Router setup.

On the PPP tab, set Config/Port Used to the CS I/O SDC address selected in the module or
RS-232 depending on how you will be connected to the data logger.

Verify the Modem Dial String setting is blank.

(Optional) If using CS 1/0O communications, the throughput can be enhanced by changing
the SDC Baud Rate from 115200 to 460800. On the Advanced tab, set the SDC Baud Rate to
460800. Note that if there are other devices on the CS I/O port, they all must be able to
support this higher baud rate.
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8.4.2.3 Set up hardware

1. Connect the cellular antenna, if it is not already connected. When using a MIMO antenna
with multiple cellular connections, connect the primary cable to Cellular and the secondary
to Diversity. If the cables are not marked in this way, they can be connected to either
antennna port.

2. Connect your data logger RS-232 or CS 1/O port to the CELL200-series module RS-232 or
CS I/0 port. Ensure the same port is used for each device, for example RS-232 to RS-232.
See Wiring and connections (p. 29).

3. If not connecting through CS I/O, provide power to the CELL200 series. The data logger
provides power through the CS /O port. USB power is not sufficient to power the CELL200
series; 12 V is required.

8.4.2.4 Set up LoggerNet
The LoggerNet Network Map is configured from the LoggerNet Setup screen.

NOTE:
Setup has two options, EZ (simplified) and Standard. Click on the View menu at the top of the
Setup screen, and select Standard view.

From the LoggerNet toolbar, click Main > Setup and configure the Network Map as described in
the following steps:

1. Select Add Root > IPPort.
2. Select PakBusPort and pbRouter.

v -BH- |PPort
v -5 PakBusPort
v pbRouter

3. Add a data logger to the pbRouter.
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4. Select the IPPort in the Network Map. Enter the CELL200 series IP address (public static IP)
or the Konect PakBus Router DNS address (private dynamic IP), along with the port
number. The address and port number are input in the Internet IP Address field separated
by a colon. Preceding zeros are not entered (for example, 070.218.074.247 is entered as
70.218.74.247). When not using Konect, the default port number is 6785.

mSetupScreen
File View Backup Tools Help

@] B B B \
Display i Add Root Add Delete Rename ﬁ] Redo
ntire blatiaork | =
b B8 IPPort Eﬁ) IPPort : IPPort
et PO 1
bR & pbRouter Hardware potes
.8 CR1000XSeries Standard

Communications Enabled

Internet IP Address

Advanced
[l call-Back Enabled

[17cP Listen Only
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5. Leave the default settings for the PakBusPort. PakBus Port Always Open should not be
checked. Enter the TCP Password; this must match the value entered in the Konect PakBus
Router setup and LoggerNet setup.

Setup Screen - Standard View
File Wiew Backup Tools Help

= <

- -
Subnet Display Add Root

MNetwaork Map i

M Hardware Mew PakBus Modes Motes
%) PakBusPort —_

..... Communications Enabled

I []PakBus Port Always Open I

9 o

Undao Redo

T 3 D

Add Delete Rename

PakBusPort : PakBusPort

Maximum Time On-Line I 00hO0OmODs =
Beacon Interval I 00h 01 moO0s e
PakBus Verify Interval I O0h O0m 005 L2l
Advanced

Extra Response Time I 00s =
PakBus Address 4016

Delay Hangup | 00's 000 ms el
TCP Password |.ooo.oo|

6. Select the pbRouter in the Network Map and set the PakBus Address to 4070.

Setup Screen
File View Backup Tools Help
o B BV BV
Display Add Root Add Delete Rename
Entire Network
v B8 IPPort :&:
0 Dl BaEah

.
o pbRouter
o SRR e Standard

Communications Enabled

| PakBus Address |41}TO |
vance

Maximum Packet Size |993 |

1)

Undo Redo

pbRouter : pbRouter

Hardware potes

CELL200-Series 4G LTE Cellular Module 39



7. Select the data logger in the Network Map and set the PakBus Address to match that of the
data logger (default address in the data logger is 1). If a PakBus Encryption Key was entered
during data logger setup, also enter it here. Click Apply to save the changes.

Setup Screen

File View Backup Tools Help

Communications Enabled
[ call-Back Enabled

% | B .
Display = Add Root Add Delete Repame Undo Redo
Entire Network
v BB IPPort B | crioooxseries : CR1000XSeries
~ g PakBusPart
e - Hardware Schedule DataFiles Clock  Program  File Retrieval Motes
.8 CR1000XSeries Standard

— O X

.
EZ View

| PakBus Address 1
vanced

Maximum Packet Size 998

Security Code 0

Delay Hangup 00 s 000 ms

PakBus Encryption Key ‘

Mo final storage tables are defined in the station's program.
Scheduled Data Collection is disabled.

Check I Apply |Can(e|

8.4.2.5 Test the connection

After the Network Map has been configured, test the cellular connection by using the Connect

screen as shown in the following image. Click on the appropriate station and click Connect to

initiate a call to the data logger.

TIP:

The connection time is subject to many external factors. It is often less than 30 seconds but

could be up to 15 minutes. Be patient.

CELL200-Series 4G LTE Cellular Module
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If the connection is successful, the connectors icon at the bottom of the screen will come
together and clock information from the data logger will be displayed in the Station Date/Time
field. If the connection fails, a Communications Failure message will be displayed.

2 Connect Screen: CR1000XSeries (CR1000XSeries) — O x
File Edit View Datalogger Help
2 ) & B 1= -
Disconnect Collect Now Custom Station Status  File Control MNum Display Graphs Ports 8 Flags
Stations Table Moniter: Real Time Monitering Clocks
= CR1000XSeries - Show Units Adjusted Server Date/Time
6/13/2018 2:30:44 PM
Field Value

Station Date/Time
6/13/2018 2:30:44 PM

Check Set
[1Pause Clock Update

Current Program

SCWinEx1.CR1X

Send MNew... Retrieve...

[ List Alphabetically < >

Motes

~Gwrs | 0 00:00:15 Stop Interval | 0OmO01s [ |

8.4.3 Serial server mode option

In serial server mode, the module receives IP communications over the cellular network and
converts those to serial communications to pass on to the data logger. From the perspective of
the data logger, this is no different than a serial cable connecting it to a computer.

This is the mode used with CR200-Series and Edlog (CR23X, CR10X, and CR510) data loggers, and
cellular-to-RF networks. Only one IP connection at a time is supported.

NOTE:
A public static IP account must be used when the module is set up in serial server mode.
Private dynamic IP accounts do not support the serial server mode.

NOTE:
Instructions in this section assume that you have established cellular service and the SIM card
has been installed as described in QuickStart (integrated mode) (p. 10).
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8.4.3.1 Configure CELL200 series

To set up the CELL200 series in serial server mode:

1.
2.

Connect a USB cable between your module and computer.

Connect the cellular antenna, if it is not already connected. When using a MIMO antenna
with multiple cellular connections, connect the primary cable to Cellular and the secondary
to Diversity. If the cables are not marked in this way, they can be connected to either
antennna port. See Antenna connections (p. 33).

Open a web browser and go to: cell.linktodevice.com o

TIP;
If this doesn't work browse to 192.168.86.1.

On the Settings > General tab, enter the APN provided by your cellular provider.

5. Set Mode to Serial Server.

On the Settings > Serial Mode Setup tab, set Serial Server Listen Port Number. Default is
3001. This is entered along with the IP address as part of the LoggerNet configuration.

When using a CR200(X), set RS-232 baud rate to 9600 baud.

42


http://www.cell.linktodevice.com/
http://www.cell.linktodevice.com/

8. (Optional) In this mode, an Automated Power Schedule can be setup to save on battery life
or on cellular charges. Go to the Settings then Serial Mode Setup tab. Enter a Start (power-
on) Time, On duration, and Repeat cycle.

The modem automatically turns off at midnight. It turns on at the Start (power-on) Time for
the On duration. It then turns on again every Repeat cycle until midnight, at which point it
will turn off.

Status Settings 0S Update Utilities

General Serial Mode Setup Advanced

Automated Power Schedule @

Start (power-on) Time:
22:00
On duration

10 Minutes

Repeat cycle:

Every Hour

Trusted IP Host @

Addresses:

For example: With the following settings of Start (power-on) Time of 22:00, On Duration of
10 minutes, and Repeat Cycle of Every Hour the cellular module will turn on for ten minutes
only twice each day. It will turn on at 10:00 pm and 11:00 pm. It will not turn on at midnight
since it is powered off at the start of the next day.

9. (Optional) By default, the CELL200 series will accept incoming communications from any IP
address. This can be a security risk. You may specify up to four IP addresses, with wild cards,
to limit connections to only those trusted sources. Use an asterisk (*) as a wild card. For
example, a setting of 166.22.** would allow connections from devices that have IP
addresses starting with 166.22. Both IPv4 and IPv6 addresses are supported.

CAUTION:
Only set a Trusted IP address if you are familiar with their use. Consult your IT
department or Campbell Scientific for assistance.
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NOTE:
This setting does not affect outbound connections, only incoming connections.

Staying on the Settings > Serial Mode Setup tab, enter your trusted IP addresses, one per
line, in the Trusted IP Host Addresses box.

10. (Optional, for modules with static IP addresses.) To get remote access to the module you
must first set up a User Account. For security purposes there is no default account. Select
Settings > User Accounts > Logon > Create a new Account. Provide Name, Password, and
select the Permission Level. Close then Apply Changes.

Once the module has an account it can be accessed remotely using its static IP address.
Type the IP address into a web browser to be prompted for the user name and password.

8.4.3.2 Configure data logger

1. Connect to your data logger by using Device Configuration Utility.
2. Onthe PPP tab, set Config/Port Used to Inactive.

3. When using RS-232 serial server mode, it is recommended that you use a fixed baud rate
on the data logger RS-232 port. On the Com Ports Settings tab, select the RS-232 port and
set the Baud Rate to the fixed option to match the RS 232 baud rate set in the CELL200-
series module.

4. If using CS I/O communication, the throughput can be enhanced by changing the SDC
Baud Rate from 115200 to 460800. On the Advanced tab, set the SDC Baud Rate to 460800.
Note that if there are other devices on the CS I/O port, they all must be able to support this
higher baud rate.

8.4.3.3 Set up hardware

1. Connect the cellular antenna, if it is not already connected. When using a MIMO antenna
with multiple cellular connections, connect the primary cable to Cellular and the secondary
to Diversity. If the cables are not marked in this way, they can be connected to either
antennna port.

2. Connect your data logger RS-232 or CS 1/O port to the CELL200-series module RS-232 or
CS 1/0 port. Ensure the same port is used for each device, for example RS-232 to RS-232.
See Wiring and connections (p. 29).

3. If not connecting through CS I/O, provide power to the CELL200 series. The data logger
provides power through the CS I/0 port. USB power is not sufficient to power the CELL200
series; 12 V is required.
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8.4.3.4 Set up LoggerNet
The LoggerNet Network Map is configured from the LoggerNet Setup screen.

NOTE:

Setup has two options, EZ (simplified) and Standard. Click on the View menu at the top of the
Setup screen, and select Standard view.

From the LoggerNet toolbar, click Main > Setup and configure the Network Map as described in

the following steps:

1. Select Add Root > IPPort.
2. For PakBus data loggers select PakBusPort.

NOTE:

PakBus data loggers include the following models: GRANITE-series, CR6, CR3000,
CR1000X, CR800-series, CR300-series, CR1000, and CR200(X)-series.

3. Add a data logger.

4. Select the IPPort in the Network Map. Enter the CELL200 series IP address (public static IP),
along with the port number. The address and port number are input in the Internet IP
Address field separated by a colon. Preceding zeros are not entered (for example,
070.218.074.247 is entered as 70.218.74.247). For serial server mode, the default port

number is 3001.

mSetupScreen
File View Backup Tools Help

g | B

Display Add Root Add

Eatire Hetuork
E8- |PPort
- akBusPort

L. CR1000XSeries

T B

Delete Rename

Eﬁ’ IPPort ; IPPort

Hardware potes
Standard
Communications Enabled

Unda Redo

E
ET View

Internet IP Address 166, 3001

Advanced
[ call-Back Enabled

[ 7CP Listen Only
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5. For PakBus data loggers, leave the default settings for the PakBusPort. PakBus Port Always
Open should not be checked. If used, enter the TCP Password.

ESe{upScleen
File View Backup Tools Help

BT - T = T
Display Add Root

Entire Metwork
TN

-y PakBusPort

d@ PakBusPort : PakBusPort

Hardware pew PakBus Modes Motes
Standard

Communications Enabled
DPakEus Port Always Open

Add Delete Rename ‘ gnﬂn Redo ‘

Maximum Time On-Line

| oohoomons

6. For PakBus data loggers, select the data logger in the Network Map and set the PakBus
Address to match that of the data logger (default address in the data logger is 1). Click

Apply to save the changes.

BSelupScleen
File View Backup Tools Help

< )
Display v Add Root Add Delete Rename Undao Redao
Entire Network
w B8 |PPort g CR1000XSeries : CR100D0XSeries
g D

~El CR1000X5eries

Standard
Communications Enabled

[A call-Back Enabled

Hardware Schedule DataFiles Clock  Program  File Retrieval Motes

|PakBus Address 1

Maximum Packet Size 958

Security Code 1]

Delay Hangup 00 s 000 ms

PakBus Encryption Key |

Scheduled Data Collection is disabled.

Check Apply Cancel

8.4.3.5 Test the connection

After the Network Map has been configured, test the cellular connection by using the Connect

screen as shown in the following image. Click on the appropriate station and click Connect to

initiate a call to the data logger.

CELL200-Series 4G LTE Cellular Module
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TIP:
The connection time is subject to many external factors. It is often less than 30 seconds but

could be up to 15 minutes. Be patient.

If the connection is successful, the connectors icon at the bottom of the screen will come
together and clock information from the data logger will be displayed in the Station Date/Time
field. If the connection fails, a Communications Failure message will be displayed.

Connect Screen: CR1000%Series (CR1000XSeries) = ] x
File Edit View Datalogger Help

Y b B E =

Disconnect Collect Mow Custom Station Status  File Control Num?i;play Graphs Ports & Flags
Stations Table Moniter: Real Time Monitoring Clocks
=. CR1000XSeries ~ | [A Show Units Adjusted Server Date/Time
6/13/2018 2:30:44 PM
Field Value
Station Date/Time
6/13/2018 2:30:44 PM
Check Set
[JPause Clock Update
Current Program
SCWinEx1.CR1X
Send Mew... Retrieve...
[ List Alphabetically < 3
MNotes
Interval 5
B | 0 00:00:15 S S 00m Ol= =

8.4.4 Serial client mode option

This mode requires CELL200 series operating system 2.00 or newer. Find the CELL200 series OS
version in the OS Date field of the Status Tab. For more information, see Updating the operating
system and firmware (p. 65).

Status Settings OS Update Utilities

State Model
Network ready. Datalogger ready. CELL205

Network Registration Version
2G/3G : Registered CELL2xx_1.00
GPRS : Registered Serial Number
LTE : Registered 0

Signal Strength @ 0S Date
2G/3G (RSSI): -69 2020-03-02 02.025
LTE (RSRP) : -102 Interface
RS232

5§gna| Quality 9 Tx Count : 3795138
2G/3G (ECIO): unknown Bx Lol o dn
LTE (RSRQ) - -19 e

Band / Tower ID 06/19/2020, 13:43:19
4 /1594204 Power

Operator 12.81 Volts

CELL200-Series 4G LTE Cellular Module
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In serial client mode the module will connect to the cellular network and initiate a TCP client
socket connection. When data is sent to the active port (RS-232 or CS I/0) it will be sent out on
the TCP client connection. When data is received on the TCP client socket connection, it is passed
to the active port (RS-232 or CS 1/0).

Use this mode when the module is behind a cellular provider firewall and it has a private dynamic
IP address. This mode requires the receiving TCP/IP connection be on a public static IP address,
on the same private cellular network, DNS name or there be a hole in the firewall. For
connections involving firewalls, such as office networks, contact your IT department to ensure all
relevant settings are configured correctly.

When the same server IP and port are used for multiple data logger connections, each data
logger must have a unique PakBus address.

NOTE:
Instructions in this section assume that you have established cellular service and the SIM card

has been installed as described in QuickStart (integrated mode) (p. 10).

8.4.4.1 Configure CELL200 series

To set up the CELL200 series in serial client mode:

1. Connect a USB cable between your module and computer.

2. Connect the cellular antenna, if it is not already connected. When using a MIMO antenna
with multiple cellular connections, connect the primary cable to Cellular and the secondary
to Diversity. If the cables are not marked in this way, they can be connected to either
antennna port. See Antenna connections (p. 33).

3. Open a web browser and go to: cell.linktodevice.com .

TIP:
If this doesn't work browse to 192.168.86.1.

4. On the Settings tab, enter the APN provided by your cellular provider.
5. Onthe General tab, set Mode to Serial Client.
6. When using a CR200(X), set RS-232 baud rate to 9600 baud.
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7. Select the Serial Mode Setup tab.

Status Settings 0S Update
Settings
General Serial Mode Setup

Client (Qutbound) @

URL:

e

Port Number: @

Timeout: @

Always Open

Utilities

Advanced

Factory Defaults | Apply Changes

-

8. Enter the URL and Port Number of the server/device that the module will connect to.

9. (Optional) Select Always Open for the Timeout .

CELL200-Series 4G LTE Cellular Module
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10. (Optional) In this mode, an Automated Power Schedule can be setup to save on battery life
or on cellular charges. Go to the Settings then Serial Mode Setup tab. Enter a Start (power-
on) Time, On duration, and Repeat cycle.

The modem automatically turns off at midnight. It turns on at the Start (power-on) Time for
the On duration. It then turns on again every Repeat cycle until midnight, at which point it
will turn off.

Status Settings 0S Update Utilities

General Serial Mode Setup Advanced

Automated Power Schedule @

Start (power-on) Time:

22:00

On duration

10 Minutes

Repeat cycle:

Every Hour

Trusted IP Host @

Addresses:

For example: With the following settings of Start (power-on) Time of 22:00, On Duration of
10 minutes, and Repeat Cycle of Every Hour the cellular module will turn on for ten minutes
only twice each day. It will turn on at 10:00 pm and 11:00 pm. It will not turn on at midnight
since it is powered off at the start of the next day.

8.4.4.2 Configure data logger (optional)

SendVariables() is used to initiate a data logger call-back attempt to a computer running
LoggerNet. It has the following syntax:

SendVariables (ResultCode, ComPort, NeighborAddr, PakBusAddr, Security, TimeOut,
"TabTeName", "FieldName", Variable, Swath )

The ComPort needs to be set to ComRS232 or ComSDC8 depending on how you have the
module connected to the data logger. Set the TableName to "Public" and the FieldName to
"Callback". The remaining parameters in the instruction are ignored. The resulting instruction will
look similar to:

SendVariables (SendResult, COMRS232, 0, 4094, 0000, O, "Public", "Callback",
Scratch, 1)
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After LoggerNet receives the variable "Callback" it will begin collecting data from the data logger
and store it to a file based on the data collection settings in the Setup window. See the CRBasic
help for more information.

8.4.4.3 Set up hardware

1. Connect the cellular antenna, if it is not already connected. When using a MIMO antenna
with multiple cellular connections, connect the primary cable to Cellular and the secondary
to Diversity. If the cables are not marked in this way, they can be connected to either
antennna port.

2. Connect your data logger RS-232 or CS 1/O port to the CELL200-series module RS-232 or
CS 1/O port. Ensure the same port is used for each device, for example RS-232 to RS-232.
See Wiring and connections (p. 29).

3. If not connecting through CS I/O, provide power to the CELL200 series. The data logger
provides power through the CS I/0O port. USB power is not sufficient to power the CELL200
series; 12 V is required.

8.4.4.4 Set up LoggerNet
The LoggerNet Network Map is configured from the LoggerNet Setup screen.

NOTE:
Setup has two options, EZ (simplified) and Standard. Click on the View menu at the top of the
Setup screen, and select Standard view.

From the LoggerNet toolbar, click Main > Setup and configure the Network Map as described in
the following steps:

1. Select Add Root > PakBusTcpServer.
2. Add a data logger to the PakBusTcpServer.
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3. Select the PakBusTcpServer in the Network Map. PakBus Port Always Open should be
checked.

K] Setup Screen - Standard View

File View Backup Tocls Help

g | T TV B
D|sp|ay c Add Root Add Delete Rename Undo Redo
Entire Network | i
Eﬂ’ PakBusTcpServer : PakBusTcpServer
w@ PakBusTcpServer Hardware Routing Motes
; .

Standard
Communications Enabled

PakBus Port Always Open

4. Select the data logger in the Network Map. Select Call-Back Enabled; the box should have a
check.

Setup Screen - Standard View
File View Backup Tools Help

%%%"&5

Display M Add Root Add Delete Rename
Entire Metwork

gnda Rﬁdo ‘

E CR1D0DXSeries : CR1000XSeries

Hardware Schedule DataFiles Clock Program File Retrieval Motes
Standard
Communications Enabled

\..=@ CR1000XSeries

[ Call-Back Enabled

8.4.4.5 Test the connection

After the Network Map has been configured, test the cellular connection by using the Connect
screen as shown in the following image. Click on the appropriate station and click Connect to
initiate a call to the data logger.

TIP:
The connection time is subject to many external factors. It is often less than 30 seconds but

could be up to 15 minutes. Be patient.
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If the connection is successful, the connectors icon at the bottom of the screen will come
together and clock information from the data logger will be displayed in the Station Date/Time
field. If the connection fails, a Communications Failure message will be displayed.

Connect Screen: CR1000XSeries (CR1000XSeries) — O x
File Edit View Datalogger Help
» D o 5] E =
Disconnect Collect Now Custom Station Status  File Control MNum Display Graphs Ports 8 Flags
Stations Table Moniter: Real Time Monitering Clocks
= CR1000XSeries - Show Units Adjusted Ser\.rer .Date{Tlme
6/13/2018 2:30:44 PM
Field Value
Station Date/Time

6/13/2018 2:30:44 PM

Check Set
[1Pause Clock Update

Current Program

SCWinEx1.CR1X

Send MNew... Retrieve...

[ List Alphabetically < >

Motes

L (] 0 00:00:15 Stop Interval | QOmoO1s 5 |

8.4.5 Serial server/client mode option

This mode requires CELL200 series operating system 2.00 or newer. Find the CELL200 series OS
version in the OS Date field of the Status Tab. For more information, see Updating the operating
system and firmware (p. 65).

Status Settings 0S Update Utilities

State Model
Network ready. Datalogger ready. CELL205

Network Registration Version
2G/3G : Registered CELLZxx_1.00
GPRS : Registered Serial Number
LTE : Registered 0

signal Strength @ 0S Date
2G/3G (RSSI). -69 2020-03-02 02.025
LTE (RSRP) : -102 Interface
RS232

Signal Quality 9 Tx Count : 3795138
2G/3G (ECIO): unknown Ru Count - 553318
LTE (RSRQ) - -19 Time

Band / Tower 1D 06/19/2020, 13:43:19
471594204 Power

Operator 12.81 Volis

In serial server/client mode the module connects to the cellular network and opens a listening
port. When a client connects to the listening port, the CELL200 series will be in "serial server"
mode. In serial server mode, all data on the active port (RS-232 or CS 1/O) will be routed through
the listening port. When no client is connected to the listening port, the CELL200 series will be in
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"serial client" mode and all data on the active port will be sent and received through the initiated
TCP client socket connection.

The incoming connection, or serial server mode, takes precedence. An outbound, or client,
connection will be interrupted if a connection is made on the incoming, or server, listening port.

NOTE:
Instructions in this section assume that you have established cellular service and the SIM card
has been installed as described in QuickStart (integrated mode) (p. 10).

8.4.5.1 Configure CELL200 series

To set up the CELL200 series in serial server/client mode:

1. Connect a USB cable between your module and computer.

2. Connect the cellular antenna, if it is not already connected. When using a MIMO antenna
with multiple cellular connections, connect the primary cable to Cellular and the secondary
to Diversity. If the cables are not marked in this way, they can be connected to either
antennna port. See Antenna connections (p. 33).

3. Open a web browser and go to: cell.linktodevice.com o

TIP:
If this doesn't work browse to 192.168.86.1.

4. On the Settings tab, enter the APN provided by your cellular provider.
5. On the General tab, set Mode to Serial Server/Client.
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6. Select the Serial Mode Setup tab.

Status Settings OS Update Utilities

General Serial Mode Setup Advanced

Server (Listening) Port Number: @

3001

Client {Qutbound) @

URL: @
Port Number. @

Timeout: @

Always Open v

-

7. Set Server (Listening) Port Number. Default is 3001. This is entered along with the IP
address as part of the LoggerNet configuration.

8. Enter the URL and Port Number that the module will connect with.
9. (Optional) Select Always Open for the Timeout .
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10. (Optional) In this mode, an Automated Power Schedule can be setup to save on battery life

1.

or on cellular charges. Go to the Settings then Serial Mode Setup tab. Enter a Start (power-
on) Time, On duration, and Repeat cycle.

The modem automatically turns off at midnight. It turns on at the Start (power-on) Time for
the On duration. It then turns on again every Repeat cycle until midnight, at which point it
will turn off.

Status Settings 0S Update Utilities

General Serial Mode Setup Advanced

Automated Power Schedule @

Start (power-on) Time:
22:00
On duration

10 Minutes

Repeat cycle:

Every Hour

Trusted IP Host @

Addresses:

For example: With the following settings of Start (power-on) Time of 22:00, On Duration of
10 minutes, and Repeat Cycle of Every Hour the cellular module will turn on for ten minutes
only twice each day. It will turn on at 10:00 pm and 11:00 pm. It will not turn on at midnight
since it is powered off at the start of the next day.

(Optional) By default, the CELL200 series will accept incoming communications from any IP
address. This can be a security risk. You may specify up to four IP addresses, with wild cards,
to limit connections to only those trusted sources. Use an asterisk (*) as a wild card. For
example, a setting of 166.22.** would allow connections from devices that have IP
addresses starting with 166.22. Both IPv4 and IPv6 addresses are supported.

CAUTION:
Only set a Trusted IP address if you are familiar with their use. Consult your IT
department or Campbell Scientific for assistance.
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NOTE:
This setting does not affect outbound connections, only incoming connections.

Staying on the Settings > Serial Mode Setup tab, enter your trusted IP addresses, one per
line, in the Trusted IP Host Addresses box.

8.4.5.2 Configure data logger

1. Connect to your data logger by using Device Configuration Utility.
2. Onthe PPP tab, set Config/Port Used to Inactive.

3. When using RS-232 serial server mode, it is recommended that you use a fixed baud rate
on the data logger RS-232 port. On the Com Ports Settings tab, select the RS-232 port and
set the Baud Rate to the fixed option to match the RS 232 baud rate set in the CELL200-
series module.

4. If using CS I/O communication, the throughput can be enhanced by changing the SDC
Baud Rate from 115200 to 460800. On the Advanced tab, set the SDC Baud Rate to 460800.
Note that if there are other devices on the CS I/O port, they all must be able to support this
higher baud rate.

8.4.5.3 Set up hardware

1. Connect the cellular antenna, if it is not already connected. When using a MIMO antenna
with multiple cellular connections, connect the primary cable to Cellular and the secondary
to Diversity. If the cables are not marked in this way, they can be connected to either
antennna port.

2. Connect your data logger RS-232 or CS 1/O port to the CELL200-series module RS-232 or
CS I/0 port. Ensure the same port is used for each device, for example RS-232 to RS-232.
See Wiring and connections (p. 29).

3. If not connecting through CS I/0O, provide power to the CELL200 series. The data logger
provides power through the CS I/O port. USB power is not sufficient to power the CELL200
series; 12 V is required.

8.4.5.4 Set up LoggerNet
The LoggerNet Network Map is configured from the LoggerNet Setup screen.

NOTE:
Setup has two options, EZ (simplified) and Standard. Click on the View menu at the top of the
Setup screen, and select Standard view.
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From the LoggerNet toolbar, click Main > Setup and configure the Network Map as described in
the following steps:

1. Select Add Root > PakBusTcpServer.

2. Add a data logger to the PakBusTcpServer.

3. Select the PakBusTcpServer in the Network Map. PakBus Port Always Open should be
checked.

K] Setup Screen - Standard View
File View Backup Tools Help

9| T VD \
Display Add Root Add Delete Rename Undao Redo
Entire Metwaork i
Eﬂ) PakBusTcpServer : PakBusTcpServer
e EE PakBusTcpServer Hardware Routing Notes
Standard

Communications Enabled
PakBus Port Always Open

4. Select the data logger in the Network Map. Select Call-Back Enabled; the box should have a
check.

E Setup Screen - Standard View
File View Backup Tools Help

E < T TV

Display M Add Root Add Delete Rename
Entire Metwork

Qnd-:u Redo ‘

E CR1000X5eries : CR1000X5eries

Hardware Schedule Data Files Clock Program  File Retrieval MNotes
Standard
Communications Enabled

[ Call-Back Enabled

\..=@ CR1000XSeries

8.4.5.5 Test the connection

After the Network Map has been configured, test the cellular connection by using the Connect
screen as shown in the following image. Click on the appropriate station and click Connect to
initiate a call to the data logger.

TIP:
The connection time is subject to many external factors. It is often less than 30 seconds but

could be up to 15 minutes. Be patient.
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If the connection is successful, the connectors icon at the bottom of the screen will come
together and clock information from the data logger will be displayed in the Station Date/Time
field. If the connection fails, a Communications Failure message will be displayed.

Connect Screen: CR1000XSeries (CR1000XSeries) — O x
File Edit View Datalogger Help
X * & 0 E R
Disconnect Collect Now Custom Station Status  File Control MNum Display Graphs Ports 8 Flags
Stations Table Moniter: Real Time Monitering Clocks
= CR1000XSeries - Show Units Adjusted Ser\.rer .DEtEu"TII'ﬂE
6/13/2018 2:30:44 PM
Field Value
Station Date/Time
6/13/2018 2:30:44 PM
Check Set
[1Pause Clock Update
Current Program
SCWinEx1.CR1X
Send MNew... Retrieve...
[ List Alphabetically = %
Motes
L (] 0 00:00:15 Stop Interval | 00m 01 = |

9. Operation and maintenance

9.1 Ports

The CS I/O port is the main port used with Campbell Scientific data loggers. Its function is
described throughout this manual.

The RS-232 port can also be used with Campbell Scientific data loggers through a null modem
cable (or CPI/RS-232 RJ45 to DB9 cable for the CR1000X and CR6 series).

The USB port is used to check the module status, configure the module, send a new operating
system, or watch low-level communications. This is done by opening a web browser and using
the following URL: cell.linktodevice.com <

TIP:
If your computer does not have access to a DNS server, browse to 192.168.86.1.
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9.2 LED indicator lights

When your CELL200-series module is connected to power and an antenna, there is a specific
pattern to the lights to indicate its operation mode as described in LED Indicator Lights (p. 60).

Table 9-1: LED Indicator Lights

Green

Flashes every 8 seconds

Blue

Flashes with traffic

Red

Flashes every 8 seconds

network

Network  [when authenticated with  [to/from internal cell ~ |when issue with
cellular network modem network/settings
Flashes every 8 seconds to |Flashes every 8 Flashes every 8 seconds to
Signal indicate good signal seconds to indicate indicate marginal or no
strength fair signal strength signal strength
Flashes every 8 seconds to . . Used to let user know itis in
e . . Flashes with traffic on
Power/Traffic |indicate all is good in low power state (only LED

RS-232 or CS I/O

flashing)

9.3 Signal strength and quality

Both signal strength and quality contribute to successful cellular data communications. The
factors that influence signal strength and quality include but are not limited to:

e proximity to the cellular tower
 tower load

» competing signals

 physical barriers (mountains, buildings, vegetation)

o weather

Because signal strength and quality can vary due to many factors, they may not give a true
indication of communications performance or range. However, they can be useful for activities

such as:

 determining the optimal direction to aim a Yagi antenna
» determining the effects of antenna height and location
* trying alternate Yagi antenna (reflective) paths

* seeing the effect of vegetation and weather over time

CELL200-Series 4G LTE Cellular Module
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9.3.1Signal strength

Signal strength is how strong the received signal is. The closer your CELL200 series is to the
cellular tower, the more signal the antenna will pick up. Signal strengths are lower the farther
away from the tower the CELL200 series is.

For 3G networks, signal strength is reported as RSSI (Received Signal Strength Indicator). For 4G,
it is RSRP (Reference Signal Received Power).

Signal strength units are —.dBm; =70 is a stronger signal than —100.

Table 9-2: Signal strength
RSSI (3G) RSRP (4G)

Strength estimate

dBm dBm
Excellent -70 or greater|-90 or greater
Good -71to -85 -91to -105
Fair -86to-100 | -106to -115
Poor less than -100 | less than -115

9.3.2 Signal quality

Signal quality shows how much interference there is between the cellular tower and CELL200
series, or how noisy a band is. Cellular signal noise comes from reflections, ghosting and other
interference. Better signal quality is an indicator of more successful communications during
precipitation events such as rain and snow.

For 3G networks, signal quality is ECIO (Energy to Interference Ratio). For 4G, this is RSRQ
(Reference Signal Received Quality).

Signal quality units are —dBm; 0 is a better signal than —10.

Table 9-3: Signal quality
ECIO (3G) RSRQ (4G)

Quality estimate

dBm dBm
Excellent Oto-6 >-9
Good -7to-10 [-9to-12
Fair to poor -11to -20 [-13 orless

CELL200-Series 4G LTE Cellular Module
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Appendix A. Controlling power
to the CELL200 series

This example shows how to control power to the CELL200 series by using the CRBasic
IPNetPower () instruction. The program uses the TimeIsBetween () instruction to power
the CELL200 series for 15 minutes every 60 minutes between 9:00 a.m. and 5:00 p.m.

Downloadable example programs are available at www.campbellsci.eu/downloads/cell200-
example-programs 7. See the CELL2XX-Power program.

NOTE:

The IPNetPower () functionality shown in this example is available in the CR300 series with
operating system 08.00 or greater, the CR6 series with operating system 09.00 or greater, and
the CR1000X with operating system 03.00 or greater. To control power in these data loggers
with older operating systems or any CR1000, CR800 series, or CR3000, you will need to use a
SW12V port on the data logger and communicate over RS-232. When using a SW12V port, we
recommend using a PPPClose () instruction to shut down the network prior to powering
down the CELL200 series.

NOTE:
TimeIsBetween () requires operating system version 28.00 or greater in the CR1000,
CR3000, or CR800. It is supported in all CR1000X, CR6, and CR300 operating systems.

CRBasic Example 1: Turn CELL200 series ON and OFF under data logger control

'Declare Variables and Units
Pub1lic BattV

PubTic PTemp_C

PubTic ModuleState As Boolean

Units BattV=Volts
Units PTemp_C=Deg C

'Define Data Tables
DataTable(Daily,True,-1)
DataInterval(0,1440,Min,10)
Minimum(l,BattV,FP2,False,False)
EndTable

CELL200-Series 4G LTE Cellular Module
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CRBasic Example 1: Turn CELL200 series ON and OFF under data logger control

'"Main Program
BeginProg
'"Main Scan
Scan(5,Sec,1,0)
'Default Data Logger Battery Voltage measurement 'BattV'
Battery(BattV)
'Default Wiring Panel Temperature measurement 'PTemp_C'
PanelTemp(PTemp_C, 60)
'Between the hours of 9:00 and 17:00, turn the CELL200 series
'on for 15 minutes at the start of every hour
If TimeIsBetween(9,17,24,Hr) AND TimeIsBetween(0,15,60,Min) Then
ModuleState=True
IPNETPower(5,1)
Else
ModuleState=False
IPNETPower(5,0)
EndIf
'"Always turn OFF CELL200 series if battery drops below 11.5 volts
If BattV<11l.5 Then
'Set CELL200 series power to the state of 'ModuleState' variable
IPNETPower(5,0)
EndIf
"Call Data Tables and Store Data
CallTable Daily
NextScan
EndProg

CELL200-Series 4G LTE Cellular Module
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Appendix B. Configuring
settings and retrieving status
information with the CRBasic
program

B.1 Using the SetSetting() instruction

NOTE:
This functionality is available in the CR1000X, CR300-series, and CR6 dataloggers only.

Downloadable example programs are available at www.campbellsci.eu/downloads/cell200-
example-programs 7. The CELL2XX-SetSettings example shows how to set up the cellular

module using the SetSetting() instruction. It also illustrates how to retrieve status
information from the module in the CRBasic program.
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Appendix C. Updating the
operating system and firmware

Campbell Scientific updates data logger and CELL200 series operating systems (OS) as new
features are developed and bugs fixed. It is recommended that before deploying instruments,
you check operating system versions and update them as needed. This section applies to
updating the CELL200 series module operating system. Refer to your data logger manual for
information on updating its OS.

The CELL200 series itself uses two operating systems. The first is the Campbell Scientific CELL200
series operating system. We will refer to that as the CELL200 series OS. The second is contained
in the cellular radio module; we will refer to that one as the module firmware. One or both may
need to be updated from time to time.

CAUTION:
To prevent data loss, collect all data from the data logger before proceeding to update the
data logger operating system and cellular module firmware.

Updating the module firmware is done over the air (OTA), even with a direct USB connection to
the data logger. Therefore, it can take from 5 minutes to several hours depending on signal
strength between the cell tower and the CELL200 series, cellular network congestion, and OTA
server availability. OTA updates use some of the cellular device data plan for each attempt. Care
should be taken to plan accordingly to avoid cellular data plan overages.

C.1 Using the web interface
(cell.linktodevice.com)

NOTE:
Instructions in this section assume that the steps in Pre-installation (p. 2) have been

completed. Cellular service must be setup before web access using cell.linktodevice.com s
available.
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NOTE:
This section applies to modules set up in serial server mode with a public static IP account

when connecting over the Internet using the cellular interface.

This section also applies to all modules when connecting via USB.

1. Connect the Cellular antenna.
2. Connect the Diversity antenna, if used. (Not required. See Antenna connections [p. 33].)

3. (Option 1, local connection) Connect a USB cable between your module and computer.

a. Open a web browser and go to: cell.linktodevice.com o

TIP:
If your computer does not respond to the DNS server correctly, browse to

192.168.86.1.
4. (Option 2, remote connection) No additional setup for modules connecting remotely.
a. Open a web browser and enter the module static IP address.

5. Every 14 days, the module automatically checks for a CELL200 series OS update. When a
new OS is available you will see a red notification in the Version field of the Status Tab.

Status Settings OS Update Utilities
State Model
Network ready. CELL205
Network Registration Version
2G/3G : Registered CELL2xx_1.00
GPRS : Registered Update pending. See "OS Update” tab.
LTE : Registered Recommended update to 1.00.02.000
signal Strength @
2G/3G (RSSI): -67 15
LTE (RSRP) : -105 0OS Date
3 Refresh 2019-04-18 01.014
Signal Quality @ Interface
2G/3G (ECIO): unknown Cs o
LTE (RSRQ) : -17 Tx Count . 0
Rx Count : 0

Band

Time

04/30/2019, 12:41:43
Fower

12.70 Volts

4

Operator
T-Mobile

Technology

66


http://www.cell.linktodevice.com/
http://www.cell.linktodevice.com/

6. Select the OS Update Tab. Clicking the Apply Update button will retrieve the CELL200 series
OS from the Campbell Scientific website and begin the update process. If you already
downloaded the OS from the Campbell Scientific website to you computer you can click
the Send File button and follow the prompts.

Status Settings 0OS Update Utilities

OS Update

OS Update Pending
Recommended update to 1.00.02.000

Apply Update
or

Send File

7. When new module firmware is available you will see a red notification in the Celllar Modem
field of the Status Tab. To begin the update process, click the red Start Cellular Module OTA
Update button.

Status Settings 08 Update Utilities

State Model
Network ready. Checking/Retrieving updates. CELL210
Network Registration Version
GPRS : Registered CELL2xx_1.00
LTE : Registered Serial Number
Signal Strength @ 14
LTE (RSRP) : -74 ©OS Date
2019-04-18 01.014
Signal Quality @ Interface
LTE (RSRQ): 6 Cs Iio
Band Tx Count: 0
13 Rx Count : 0
Operator Time
Verizon Wireless 04/30/2019, 13:01:01
Technology Power
LTE 12.70 Volis
Data Usage (KB) Cellular Modem
Today: 70.23 Phone
Yesterday: 0 IMEI : 8
Month: 70.23 ICCID
Last Month: 4.14 IMS1: 3
IP Info
1Pv4 Address: 166.167.34.99 Firmware State : Update recommended (V12 to V13)
Default Gateway: 10.64.64.64
DNS: 198.224 173135

DNS: 196.224.174.135
DNS: 208 67 222 222

Qaruar Cannactinn” Clacard
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C.2 Using Device Configuration Utility

NOTE:

This section applies to modules set up in integrated PPP mode which requires data logger
operating system 03.00 or later for the CR1000X, 09.00 or greater for the CR6 series, and
08.00 or later for the CR300 series.

1. Connect the cellular antenna, if it is not already connected. When using a MIMO antenna
with multiple cellular connections, connect the primary cable to Cellular and the secondary
to Diversity. If the cables are not marked in this way, they can be connected to either
antennna port. See Antenna connections (p. 33).

2. Connect your data logger to the CELL200-series module RS-232 or CS I/O port. See Wiring
and connections (p. 29).

If not connecting through CS I/O, provide power to the CELL200 series.
Connect a USB cable between your data logger and computer.

Connect to your data logger by using Device Configuration Utility.

o v~ W

When a new CELL200 series OS is available, in the Settings Editor on the Cellular Tab you
will see a field called Cellular OS Update Pending. This field does not appear unless an
update is available. Select Apply Update to begin the process, or Ignore to update at
another time.

7. Apply to save your changes.

Detnce: Tipie Settings Editor
Q) search [ |
T IO JTTTeS
A
CRI10X-PE Datalogger CSI/OIP PPP Network Services  WiFi  ComPorts Set‘hng{ Cellular Ethernet Advanced TLS
CR200 Series celllar State
CR23X-PB Network ready. Datalogger ready.
. Cellular Q5 Update Pending
CR3000 Apply Update

CR510-PB PN

CR& Series ‘

CRE00 Series Start {power-on) time
CRVW Series AlwaysOn  ~

GRANITE 10 On duration

8. When new module firmware is available, in the Settings Editor on the Cellular Tab you will
see a field called Cellular Module OTA Update Pending. This field does not appear unless
an update is available. Select Start Update to begin the process, or Ignore to update at
another time.
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9. Apply to save your changes.

Device Type Settings Editor
| ]

| Q Search @J |

Camera ~

Bl Cellular Modem
L5300
Raven XT

= Datalogger

CR.1000

CR10X-PB
CR.200 Series
CR23X-PB

Datalogger CSI/OIP PPP Network Services ComPorIsSetting4 Cellular kthemet Advanced TLS

Cellular State

MNetwork ready. Datalogger ready.

|Start Update  ~ |

e
APN

e e an

S_I__aﬂ:_(power-onjl time:
|Always On  ~ |

CELL200-Series 4G LTE Cellular Module
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Appendix D. Cellular module
terminal functionality

This appendix discusses the terminal functionality of the CELL200-series modules. This
functionality requires a data logger with a CS I/O port.

To use the terminal functionality of the module, you must enable the terminal port. To do this:

1. Connect a USB cable between your module and computer.

2. Connect the cellular antenna, if it is not already connected. When using a MIMO antenna
with multiple cellular connections, connect the primary cable to Cellular and the secondary
to Diversity. If the cables are not marked in this way, they can be connected to either
antennna port. See Antenna connections (p. 33).

3. Open a web browser and go to: cell.linktodevice.com o

TIP:
If this doesn't work browse to 192.168.86.1.

4. On the Settings > Advanced tab, set the Terminal Port CS I/0O SDC Address. (It must be set
to a different address than the one used for the CS I/O Port SDC Address.)

5. Click Apply Changes.

Using the SetSetting() instruction (p. 64) illustrates how to use this functionality in a CRBasic
program.

The functionality can also be accessed directly using the terminal emulator of the data logger in
serial talk through mode. The data logger terminal emulator can be accessed by connecting to
the data logger in Device Configuration Utility and selecting the Terminal tab. (It can also be
accessed from the Connect screen by selecting Datalogger | Terminal Emulator and then clicking
Open Terminal.) With the terminal window open, press return a few times until you receive the
data logger prompt (for example, CR1000X>). Type P. Then type the number corresponding to
the Terminal Port CS I/O SDC Address set in the CELL200-series module. You should receive a
CELL2xx> prompt. The commands in this appendix can be used from this prompt to interact with
the CELL200-series module.

help

Displays all the commands that are available in the cellular module terminal.
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D.1Using cell modem terminal functionality

NOTE:
This functionality is available in all CRBasic data loggers with a CS I/O port.

Using cell modem terminal functionality (p. 71) shows how to set up an attached CELL200-series
module using the terminal functionality in the module. It also illustrates how to use the same
functionality to retrieve status information from the CELL200 series and put the module into low
power mode. Downloadable example programs are available at
www.campbellsci.eu/downloads/cell200-example-programs. [ See the CELL2XX-
Settings program for details.

To use the terminal functionality of the module, you must enable the terminal port. To do this:

1. Connect a USB cable between your module and computer.

2. Connect the cellular antenna, if it is not already connected. When using a MIMO antenna
with multiple cellular connections, connect the primary cable to Cellular and the secondary
to Diversity. If the cables are not marked in this way, they can be connected to either
antennna port. See Antenna connections (p. 33).

3. Open a web browser and go to: cell.linktodevice.com o

TIP:
If this doesn't work browse to 192.168.86.1.

4. On the Settings | Advanced tab, set the Terminal Port CS 1/0 SDC Address. (It must be set
to a different address than the one used for the CS I/O Port SDC Address.)

5. Click Apply Changes.

D.2 Status commands

Status commands show current values of the information being requested. Some correspond to
settings and others are tied to diagnostic information. All values returned are strings. Not all
modems return all values. Values returned are also dependent on the network the device is
connected to.
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show acc tech

show apn

show arev

show band

show bat

show baud

show billing

show cell id

show cellular errors

show cellular Info

show cellular log

show client port

show client timeout

show client url

show device info

show diagnostic report

Returns the access technology of the network that the modem is
connected to.

Displays the APN (Access Point Name) currently used by the cellular
module. Corresponds with the APN setting in the cellular module
web interface.

Returns the alternate or subversion revision of the CELL200 series
OS.

Returns the band number the modem is using to connect to the
cellular network.

Returns the current modem battery voltage.

Displays the current baud rate of the cellular module RS-232 port.
Corresponds with the RS232 Baud Rate setting in the cellular
module web interface.

Displays the current value for the billing cycle day. Values can range
from 1to 31. Corresponds to the Billing Cycle Day field in the
cellular module web interface.

Returns the hexadecimal number of the cellular tower the modem
is connected to.

Returns an error information summary for troubleshooting.

Returns the modem cellular information. Information returned is
extensive and includes information from other terminal commands.

Returns a log of events for the device. Useful for troubleshooting.

Returns the port number in the modem when used in Serial Client
Mode.

Returns the time, in seconds, used in Serial Client Mode.

Returns the cellular module Client (Outbound) URL setting (used in
Serial Client Mode).

Returns the modem device information. Information returned is
extensive and includes many values returned from other terminal
commands.

Returns a diagnostic report that is useful for troubleshooting.
Combines the output of many other terminal troubleshooting
commands.
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show diversity

show ecio

show euiccid

show iccid

show imei

show imsi

show ip info #net

show ipprotocol

show listen port

show mod arev
show mod manu
show mod model
show mod rev

show mode

show model

show modupdate
description

Displays the current setting of cellular module antenna
configuration. Results are Disabled or Enabled. Corresponds with
the Diversity Antenna field in the cellular module web interface.

Returns the modem 3G network signal quality (ECIO).

Returns the modem EUICCID (Embedded SIM identification)
number.

Returns the modem ICCID (SIM identification) number.

Returns the modem IMEI (International Mobile Equipment Identity)
number.

Returns the modem IMSI (International Mobile Subscriber Identity)
number.

Returns the modem TCP/IP information for each network. When
using this command, replace #net with 1for the PPP connection, or
2 for the Ethernet over USB (RNDIS) connection.

Displays the current value of the cellular module IP protocol
configuration. Results are IPv4, IPv6, or IPv4/IPv6. Corresponds with
the IP Protocol field in the cellular module web interface.

Displays the current setting for the cellular module TCP/IP listening
port (used in Serial Server mode). Values can range from 1to
65535. Corresponds with the Serial Server Listen Port Number
setting in the cellular module web interface.

Returns the alternate or sub revision of the modem radio chipset.
Returns the manufacturer of the modem radio chipset.

Returns the model number of the modem radio chipset.

Returns the model revision of the modem radio chipset.

Displays the current operating mode of the cellular module. Results
are PPP, Serial Server, Serial Client, or Serial Server/Client.
Corresponds with the Mode setting in the cellular module web
interface.

Returns the model information of the modem. Returned values are
CELL205, CELL210, CELL215, or CELL220, CELL225.

Returns the description or revision history of the firmware update.
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show modupdate
description

show modupdate pending

show modupdate priority

show modupdate progress

show operator

show osdate

show osupdate description

show osupdate pending

show osupdate priority
show osupdate progress
show pdp pass

show pdp user

show phone

show ping

show power duration
show power repeat
show power start
show ppp pass

show ppp user

show reg 3g

show reg gprs

show reg Ite

Returns a description of the module firmware update for user
review.

Returns information regarding the module firmware. Informs the
user that an update is available.

Returns the priority of the module firmware update, whether it is
required or recommended.

Returns the progress of the module firmware update.

Returns the name of the cellular provider or network operator the
modem is connected to.

Returns the build date and alternate version of the CELL200 series
OS.

Returns a description of the newer operating system for the user to
review before installing.

Returns information indicating if a newer modem operating system
is available.

Returns the priority of the operating system update.
Returns the progress of the CELL200 series OS update.
Returns the modem PDP password.

Returns the modem PDP username.

Returns the modem phone number.

Returns the status of the cellular module ping setting.
Returns the modem on-duration time, in minutes.
Returns the modem Repeat cycle setting.

Returns the modem Start (power-on) Time.

Returns the modem PPP password.

Returns the modem PPP username.

Returns information on whether or not the modem is registered on
the 3G network.

Returns information on whether or not the modem is registered on
the GPRS network.

Returns information on whether or not the modem is registered on
the LTE network.
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show rev

show roaming

show rsrp
show rsrq
show rssi

show sdc

show sdc term

show serial
show settings
show sms log

show smssca

show sms rx

show sms send (id)

show sms tx

Returns the revision of the CELL200 series OS.

Displays the current setting for the modem roaming capabilities.
Returned values are Auto and Disabled. Corresponds to the
Roaming setting in the cellular module web interface

Returns the modem LTE network signal strength (RSRP).
Returns the modem LTE network signal quality (RSRQ).
Returns the modem 3G signal strength information (RSSI).

Displays the current setting for the modem SDC address. Values are
7,8,10, or 11. This value corresponds with the CS I/O Port SDC
Address setting in the cellular module web interface.

Returns the current value for the SDC terminal interface in the
modem. Returned values are 7, 8,10, and 11. Corresponds to the
Terminal Port CS I/O SDC Address setting in the cellular module
web interface

Returns the serial number of the modem.
Returns all the settings of the cellular modem.
Returns a log of SMS messaging logs.

Returns the modem SMSSCA (SMS Service Center Address)
number.

Returns the SMS receive queue.

Returns the status of an SMS message. The message ID is
contained in the results of the sms send command. Result codes
are the same as those returned by SMSSend (). A result code of -1
means the message was successfully sent to the network. See the
CRBasic help ' for more information.

Returns the SMS transmit queue.
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show state Returns the modem state in English. Values returned could include
(but not limited to) "Power off.", "Powering up.", "Powered up.",
"SIM authorized.", "Setting baud rate.", "Waiting for baud rate.",
"Baud rate set.", "Baud rate failure.", "Power off. Waiting for retry.",

"Powered up. SIM auth failure.", "Querying modem.", "Waiting for
network registration.”, "Configuring modem.", "Dialing.", "Dialing
(retry).", "Dialed.", "PPP negotiation.", "Network ready.", "PPP

closing.", "PPP paused.", "PPP dropped.", "Terminal AT command

non nwonu

mode.", "Firmware update mode.", “Shutting down.”
show state num Returns the state number associated with show state values.

show time Returns the modem current time. Time returned by the modem is
set by the cellular network.

show trusted 1 Returns the address or DNS Name in the 1st field of the cellular
module Trusted IP Host setting.

show trusted 2 Returns the address or DNS Name in the 2nd field of the cellular
module Trusted IP Host setting.

show trusted 3 Returns the address or DNS Name in the 3rd field of the cellular
module Trusted IP Host setting.

show trusted 4 Returns the address or DNS Name in the 4th field of the cellular
module Trusted IP Host setting.

show update check Returns information concerning the last update check.

show update results Returns the results of a modem operating system update.

show usage lastmonth Returns the number of bytes used across the cellular network in the

previous month.

show usage month Returns the number of bytes used across the cellular network in the
current month.

show usage today Returns the number of bytes used across the cellular network since
midnight.
show usage yesterday Returns the number of bytes used across the cellular network

during the previous day.

D.3 Set commands

Set commands are used to set specific settings in the device. Most settings will not take effect
until the module is rebooted.
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set apn ### Sets the APN (Access Point Name) in the device. Corresponds to
the APN setting in the modem web configuration interface. ### is a
string the corresponds to the APN issued by the cellular provider
when the cellular account was created.

set baud ### Sets the modem baud rate for the RS-232 port. ### is a number
corresponding to the desired baud rate. Accepted values are
460800, 230400, 115200, 76800, 57600, 38400, 19200, 14400, 9600,
4800, and 2400.

set billing ### Sets the billing day that will be used to roll over the data usage

statistics in the modem. ### is a number. Accepted values are 1
through 31.

set client port ### Sets the client port number used in serial client and serial
client/server modes. ### is a number. The accepted range is 1
through 65535.

set client timeout ### Sets the timeout, in seconds, used by serial client and serial
client/server modes. ### is a number. The accepted range is 1
through 120.

set client url ### Sets the client URL or TCP/IP address used in serial client and serial
client/server modes. ### is a string.

set comms watch This command is interactive and allows the user to watch or do a
trace on a specific modem interface. The user selects a number
corresponding with the interface they wish to view.

set div ### Sets the modem antenna configuration. ### is a string. Disabled
and Enabled are the only two values that are accepted.

set ipprotocol ### Sets the TCP/IP protocol used by the modem when communicating

with the cellular network. ### is a string. Accepted values are IPv4,
IPv6, and IPv4/IPv6.

set listen port ### Sets the listening TCP/IP port of the modem for use in serial server
and serial client/server modes. ### is a number. The accepted
range is 1through 65535.

set mode ### Sets the modem operating mode. ### is a string. Accepted values
are PPP and Serial Server.

set pdp pass ### Sets the PDP password. ### is a string.

set pdp user ### Sets the PDP username. ### is a string.
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set power duration ###

set power repeat ###

set power start ###

set ppp pass ###
set ppp user ###

set roaming ###

set sdc ###

set trusted 1 ###

set trusted 2 ###

set trusted 3 ###

set trusted 4 ###

set ping ###

Sets the on duration, in minutes. ### is a number. Accepted values
are: 5,10, 15, 20, 25, 30, 35, 40, 45, 50, 60, 120, 180, 240, 300, 360,
420, 480, 540, 600, 660, 720, 780, 840, 900, 960, 1020, 1080, 1140,
1200, 1260, 1320, 1380, and 1439.

Sets the modem repeat cycle. ### is a number. Accepted values
are: 1441, 15, 20, 30, 40, 50, 60, 120, 180, 240, 300, 360, 420, 480,
540, 600, 660, and 720. A value of 1441 or greater will disable the
repeat cycle.

Sets the modem Start (power-on) Time, in minutes. ### is a
number. Only 15 min increments are accepted (0, 15, 30 to 1440). A
value of 1440 will set the modem to “Always On”.

Sets the PPP protocol password. ### is a string.
Sets the PPP protocol username. ### is a string.

Sets the roaming capabilities of the cellular modem. ### is a string.
Accepted values are Auto and Disabled.

Sets the modem SDC address for the CS I/O port. ### is a number.
Accepted values are 7, 8,10, and 11.

Sets the address or DNS Names in the 1st Trusted IP Host field. ###
is a string.

Sets the address or DNS Names in the 2nd Trusted IP Host field.
##4# s a string.

Sets the address or DNS Names in the 3rd Trusted IP Host field.
##4# is a string.

Sets the address or DNS Names in the 4th Trusted IP Host field.
##4# s a string.

Enables or disables ping in the modem. ### is a string. Disabled
and Enabled are the only two values that are accepted.

D.4 Action commands

Action commands are used to perform actions on the modem such as entering low power mode,
rebooting, checking for updates, clearing usage, and more.
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check update

clear logs
clear usage

deep sleep

ping ###

reboot

refresh network

reset module

sms receive

sms send phone number
message

start modupdate

start osupdate

wakeup

Starts the process that checks for both a new CELL200-series
operating system, and module firmware.

Resets all the logs in the modem.
Resets the usage counts in the modem.

Puts the modem into low power mode. Modem will not respond
across the cellular network.

Used to ping a specific TCP/IP address or DNS name via the
terminal. ### is a string. For example: ping 8.8.8.8 or ping
jarvis.aglt.net.

Forces the modem to reboot.

Forces the modem to refresh its connection to the cellular network.
Useful for when the network goes stale (long periods of inactivity).

Resets the cellular chipset only.
Receives an SMS message.
Example:

sms receive
03/14/2100:57:57
5557654321
Hi, SMS test

Sends an SMS message to a phone number. Result includes a
message ID.

Example:

sms send 5551234567 Hi, SMS test
SMS queued. ID:65536

Starts the over-the-air module firmware update.

Starts the over the air (OTA) CELL200-series operating system
update process. Not for use with a direct connection.

Brings the modem fully back online. Usually done on a schedule
after a deep sleep command has been issued.
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Appendix E. Verizon Wireless
and AT&T

NOTE:

Campbell Scientific can provide Verizon Wireless or AT&T service. This is the simplest way to
set up your module on the Verizon Wireless or AT&T network. See Campbell Scientific cellular
data service (p. 3).

E.1Verizon Wireless

What you need:

» Verizon Wireless 4G LTE CAT-1 coverage at the data logger site. For a coverage map, refer
to: www.verizonwireless.com/landingpages/better-matters/#maps =

 Verizon Wireless 4G LTE private dynamic IP account in conjunction with Campbell Scientific
Konect PakBus Router Service. (A Verizon Wireless 4G LTE static unrestricted IP account can
also be used. However, Verizon generally requires new users to have 50 lines of service to
obtain the static unrestricted IP account. Also, there is generally a $500 one-time-per-
customer charge to activate static IP on the account.)

To set up an account, you will need the IMEI number of the module. The IMEI number is listed on
a label on the module. To set up an account with Verizon Wireless, call:

800-526-3178 for Business Sales
800-256-4646 for Personal Sales

Verizon Wireless will provide a SIM (Subscriber Identity Module) card for each module. The
Micro-SIM (3FF) (6 position / contacts) card must be installed inside of the module as described
in Install the SIM card (p. 4). In addition to the SIM card, you should receive:

 10-digit MSISDN number (telephone number associated with the SIM, used for billing)

e An APN (Access Point Name) for 4G LTE CAT-1 service. A common APN used for this
application is: VZWINTERNET. The user must program the APN into the module.

» For static IP accounts only, an IP Address will be included.
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E.2 AT&T

What you need:

o AT&T 4G LTE CAT-1coverage at the data logger site. For a coverage map refer to:
www.att.com/maps/wireless-coverage.html .

o AT&T 4G LTE private dynamic IP account in conjunction with Campbell Scientific's Konect
Router Service. (An AT&T 4G LTE static unrestricted IP account can also be used. However,
AT&T charges $3/month/device for the static IP account.)

To set up an AT&T account, contact your AT&T Business Account Representative or Blu-
Telecommunications.

Blu-Telecommunications is part of the Alliance Channel with AT&T and can assist any customer
nationwide. Blu-Telecommunications will contact AT&T and work with an AT&T account manager
to set up an account.

Contact information for Blu-Telecommunication:

Website: www.blu-tel.com

Phone number: (877) 422-2616, or Email box: i2gold@blu-tel.com
What to ask for: M2M Setup

Who to ask for: Carlos Morales or Andy Tran

An APN (Access Point Name) must be added onto the account to make the module accessible
through the Internet. For networks with fewer than 30 modules, the standard '12Gold APN' can be
used; networks with more than 30 modules will require a ‘Custom APN'. A Custom APN has a
setup fee starting at $500 and takes a minimum of 7 to 14 business days to complete. The user
must program the APN into the module.

AT&T will provide a Subscriber Identity Module (SIM) card for each module. The Micro-SIM (3FF)
(6 position / contacts) card must be installed inside of the module as described in Install the SIM
card (p. 4). In addition to the SIM card, you should receive:

» 10-digit MSISDN number (telephone number associated with the SIM, used for billing)

e An APN (Access Point Name) for 4G LTE CAT-1 service. A common APN used for this
application is: BROADBAND. The user must program the APN into the module.

 For static IP accounts only, an IP Address will be included.
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Appendix F. Cellular module
regulatory information

F.1 Important information for North
American users

NOTE:

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency energy and, if
not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this equipment in a residential area is
likely to cause harmful interference, in which case the user will be required to correct the
interference at his own expense.

WARNING:
Changes or modifications to this device not expressly approved by Campbell Scientific could
void the user’s authority to operate this equipment.

F.2 RF exposure

In accordance with FCC/IC requirements of human exposure to radio frequency fields, the
radiating element shall be installed such that a minimum separation distance of 20 cm should be
maintained from the antenna and the user’s body.

WARNING:
This product is only to be installed by qualified personnel.

To comply with FCC/IC regulations limiting both maximum RF output power and human
exposure to RF radiation, the maximum antenna gain must not exceed the specifications listed in
the following tables for the device used.
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FCCID

Device Frequency Band XMR201606EC21A
WCDMA Band 2 9.5 dBi
WCDMA Band 4 6.5 dBi
WCDMA Band 5 14.9 dBi
CELL205
LTE Band 2 9.0 dBi
LTE Band 4 6.0 dBi
LTE Band 12 10.7 dBi
LTE Band 4 6.5 dBi
CELL210
LTE Band 13 10.6 dBi

F.3 EU

Campbell Scientific hereby declares the CELL200-series devices are in compliance with the
essential requirements and other relevant provisions of Directive 2014/53/EU" (RED Directive).

The CELL215 displays the CE mark.

C€

WARNING:
Changes or modifications to this device not expressly approved by Campbell Scientific could
void the user's authority to operate this equipment.

WARNING:
This product is only to be installed by qualified personnel.

The Declaration of Conformity made under Directive 2014/53/EU" (RED Directive) is available for
viewing at: www.campbellsci.eu/cell215. [

F.4 UK

Campbell Scientific hereby declares the CELL200-series devices are in compliance with the
essential requirements and other relevant provisions of Regulation 2017 No. 1206 (The Radio
Equipment Regulations 2017).

CELL200-Series 4G LTE Cellular Module 83


https://www.campbellsci.com/cell215#documents_

UK
CA

WARNING:
Changes or modifications to this device not expressly approved by Campbell Scientific could
void the user’s authority to operate this equipment.

WARNING:
This product is only to be installed by qualified personnel.

The Declaration of Conformity made under Regulation 2017 No. 1206 is available for viewing at:
www.campbellsci.eu/cell215. [
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